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The Artlantis Family
Artlantis combines the most advanced and effective functions for realistically simulating the material and lighting
effects needed for any three-dimensional project. Artlantis Render communicates directly with the leading CAD archi-
tecture software (such as ArchiCAD, VectorWorks, SketchUp, AutoCAD, etc.) and can import the main CAD file
formats: DXF, DWG, 3DS, DWF, OBJ, FBX SKP.
Artlantis technology is available in two main versions, offering a product line suited to different needs and practices.

Artlantis Render - Radiosity for fixed images

Artlantis Render is a unique and ideal tool for performing very high resolution rendering easily and in real time. The
FastRadiosity™ engine lets you calculate radiosity images... with preview in real time. Artlantis Render uses 3D com-
ponents and 3D vegetation directly in the preview window by simply dragging and dropping them. This enables
users to work quickly on the various scenarios and simulate virtual scenes in a real environment.

Artlantis Studio - Animation for everyone

Artlantis Studio is the perfect tool for professionals who design presentations based on fixed images, animation,
QuickTime VR panoramas, etc.
Equipped with the new FastRadiosity™ engine, Artlantis Studio offers advanced functions such as scene animation
and object animation, to name just a few. Just like with most Artlantis functions, camera pan, viewpoints and aim
points are defined easily and intuitively.

Artlantis Media

In addition to the standard library, Abvent offers theme-oriented CD-ROMs that provide a multitude of materials and
3D objects that you can use to produce composite images. These are produced specially for Artlantis by a number of
industry partners or independent designers.

Page - 1



Chapter 1

This icon indicates functions that are particular to the Artlantis Studio version.

Artlantis 4 New Features

General Points

Artlantis is now a 64 bit program.

Viewpoint Inspectors

Tone Settings post-process with separate treatment for light and dark tones.See "Tone Settings" page 160

Materials

Split a material by Mesh, giving the possibility to apply a different treatment. See "Split Material by Mesh" page
124
New way to reaffect a Material by creating a new material or using an existing one.See "Reaffect a Material"
page 122
Shader creation adding the Fresnel Effect. A new Fresnel transition slider is displayed.See "Create Shader and
Shader Interface Match:" page 107
Projection settings new item:Horizontal projection. The Shader is required to be set horizontally. See "Horizontal:
the Shader is required to be set horizontally." page 121
New surface Fresnel Shader (diffuse and transparent).
Clearness of the textures.
Material and texture colors: more faithful rendering of colors (grayish veil over).

Heliodons

New physical 3D sky, much deeper with better horizon color gradation.

Objects

Objects Inspector a multiple selection of objects is now possibleSee "Multiple selection" page 137
Gravity can be applied to an object, makes it possible to be set precisely on a surface.
In 2D View object's a single or multiple duplication of an object follows the topography of the scene, e.g. a tree
duplicated along a path on a hill follows the slope of the hill.See "The multiple duplication of objects follows the
topology of the geometry. Example: a tree duplicated along a path on a hill will follow the different heights of this
hill." page 37

Panoramas (Studio only)

New integrated Multi-nodes panoramas authoring tool.
Multi-nodes management with multiple links.
Flash Player generator for Web publishing (free of use).
Conversion tool to iVisit 3D1 (a multi-node panorama player for iOS).

Rendering

Artlantis Batch Rendering now offers the possibility of editing the document settings before the final rendering.See
"Artlantis Batch Render" page 171
Rendering speed is much faster than on Artlantis 3: it is now at least twice as fast and is up to seven times faster
when the scene uses Neon Light or Neon Glazing Shaders.
Radiosity enhanced, better energy diffusion, better treatment of transparency, less artefact and better neon lighting dif-
fusion.

1This is an iOS application for iPad, iPhone or iPodTouch. It is used to view Artlantis pan-
oramas.
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- Opening Old Artlantis Files

Opening Old Artlantis Files

Opening Artlantis 2 files

By default, the files will keep the same appearance as in version 2. The Radiosity rendering settings will be under
Custom in the drop-down menu. According to the type of view you can redefine an interior or exterior lighting type.
You can also define other custom settings - see Expert Rendering Parameters.

Opening Artlantis 1.2 files

Scenes produced in Artlantis 1.2 must be converted.
Shaders Inspector

Texture Definition Controller

In Artlantis 3, the software engine automatically computes the level of texture definition.

Modifying the Material Definition

In earlier versions of Artlantis (including version 1.2), material definition was based on an "Extended Phong"
model that was perfectly suited to rendering for launching rays, but was not appropriate for radiosity. Artlantis 3.0
interprets material components more realistically. The definition of Shaders is not changed by compatibility concerns
with the Shader collection acquired.

Viewpoints Inspector
The old Atmosphere function is no longer supported and more advanced functionalities are available in the Hel-

iodons inspector (simulation of sky and sun, natural fog, cloud editor).
The two-color gradation has been replaced with a new three-color gradation.
Gradation rotation is no longer supported.
Depth of field effects are slightly different.
The hatch engine is no longer available and has been replaced by the Post-Process Effects.

Heliodons Inspector
The radiosity contribution check box has been removed. The sun and sky contribute to overall illumination.
Five colors have been deleted for customizing the sky. Artlantis 3 uses a new sky and sun simulation with natural

lighting. When files produced in 1.2 are opened, they are converted to this new physical simulation model.
Lights inspector

Artlantis 3 uses a physical light model that is not compatible with the version 1.2 light settings.
The radiosity contribution check box has been removed. The light contributes to overall illumination.
The parallel light has been removed.
The spot and lighting point are merged under lights.
The blurred shadow and transition parameters have been removed and replaced by a variable that is available for all

lights.
Catalog

It is no longer necessary to catalog the media folder.
Simply specify your preferred folder.

System Requirements

Minimum System Requirements

l Intel Dual-Core 2.66 GHz or equivalent
l CPU running at 2.66 GHz
l RAM : 4 GB for 32 bit or 8 GB for 64 bit computer.
l System: Windows Vista Home Basic or Vista Home Basic 64 bit
l 256 MB graphics card, OpenGL 1.4 capable.
l Display resolution: 1280 x 1024 million colors
l Internet access
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l QuickTime™7.7
l 3-button mouse with wheel.

** Graphic chipsets are not supported.

Recommended System Configuration

l Intel Xeon® Intel 6, 8 Core, Core i5 or i7
l Windows Vista or Windows 7 or Windows Vista 64 bit or Windows 7 64 bit
l 1 GB graphics card, OpenGL 1.4 capable.
l Display resolution: 1600x 1200 or greater

Installation

l Be in Administrator session.
l Follow the steps: Users License, Customized Installation, Installation Disk.
l By default, an Artlantis folder is created at the first level of the Programs folder. In this folder are installed

the executables. The folder contains the following: Artlantis, Artlantis Batch, Artlantis KeyServer, and the
Media folder.

l The online help is accessible from the menu: Help > Artlantis Help.
l Sample files are available into the Scenes folder installed in the Artlantis 4 folder.

NB: When first launching Artlantis, the Firewall displays a QTSocketServer process to reach the network.
Please authorize to assure the compatibility of certain Artlantis 32 bit components running in 64 bit.
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Serialization

About the Software activation.

In this chapter you will learn about the following subjects:

Activating and Evaluating Artlantis 5
License Activation for Windows 5
Deactivating the License 7
Evaluation Period 8
Installing and activating network licenses 9

Activating and Evaluating Artlantis
The first time Artlantis is launched, the activation and evaluation dialog box appears, as shown below:

License Activation for Windows

By Internet

First:

l Locate the serial number (composed of two numbers separated by a dash) shown on your registration card or
which was e-mailed to you.

l Check that you are connected to the Internet. Artlantis will have to connect to the activation server.

NB: when launched, Artlantis will check automatically for an Internet connection.

l Enter the serial number.
l Click on the Activate License button. A message will be displayed confirming activation. Close the message to

display the open file dialog.
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NB: *the serial number can be used regardless of whether you are using a Mac or Windows.

Potential Problem

License Cannot Be Validated:

The maximum number of users associated with the license in question has been reached. To activate the license
number on a new workstation, you must first deactivate it on the workstation(s) currently using this license*. You
can then activate the number on the new workstation. Another solution is to purchase a new license at a reduced cost.
Contact your reseller for more information.

NB: * You do not have to uninstall the software. Simply deactivate the license.

Manual

In case of no Internet connection.

l Locate the serial number (composed of two numbers separated by a dash) shown on your registration card or
which was e-mailed to you. Note down the identification number located on the license handler (this number
is encrypted).

l Use a machine connected to the Internet and go to the Artlantis activation site at: http:/-
/activation.artlantis.com

l Once the activation page appears, enter the identification number that you had written down earlier then click on
the button "Connect to server".
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Serialization - Deactivating the License

You will be issued with a license number that you will need to copy and paste in the Enter your Activation code
field of the license handler.
Click the Close button to confirm

Deactivating the License
Help Menu> Edit License… click Deactivate.

To deactivate the license, click on "Deactivate license". Then click Close.

Manual

In case of no Internet connection.
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l Click on the Deactivate license button then confirm the deactivation.

l Note down the identification number located on the license handler (this number is encrypted).
l Use a machine connected to the Internet and go to the Artlantis activation site at: http:/-

/activation.artlantis.com

l Once the activation page appears, enter the identification number that you had written down earlier then click on
the button "Connect to server".

The server will send you a code number that you need to copy and paste in the Enter the deactivation code field in
the License Manager.

l Click on the Close button, then validate to confirm the deactivation.

Evaluation Period
Clicking on "Evaluate" launches Artlantis in evaluation mode for 30 days. All of the application's commands are oper-
ational for this period of time: Open, Save, etc. The only restriction is that the Artlantis demo logo appears at the bot-
tom of renderings.
The application will no longer open files after the 30-day trial period has expired. However, it will continue to start up
so it can be activated. Contact your reseller to purchase a license.
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Serialization - Installing and activating network licenses

l Click on "Activate License" to access the activation dialog.
l Click on "Quit" to close the program.

NB: With the licensed version, you can continue any work you started using the evaluation version.

Installing and activating network licenses

Purpose:

Using the Artlantis Keyserver enables you to launch Artlantis on a specific number of client computers connected to
the same network.
At an instant t, Artlantis can be launched on x-number of client workstations simultaneously (with "x" being the
number of licensed workstations). Once it is launched on x-number of workstations, Artlantis will not launch on any
additional workstations without first closing it on one of the stations where it is open.

Requirement:

l A single network with Mac and/or PC workstations connected (Important: no sub-network).
l A special "Network" serial number.
l The Artlantis Keyserver application located in the Artlantis installation directory.

Installation:

Install and validate the license either over the Internet (recommended) or manually.
Step 1 - Activate the network license on the server

l On a LAN, select the computer that will act as the server*, then launch ArtlantisKeyserver in the Artlantis instal-
lation folder.

* The server can be any computer connected to the network. It is best to select a computer that is connected to the
Internet.

l Click on "Edit License...". The license manager is displayed.
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Validation by Internet:

l Enter the network number (composed of two numbers separated by a dash) shown on your registration card or
which was e-mailed to you. Then click on Activate License. A message should confirm that the license has been
activated correctly.

Validating manually:

l Locate the serial number (composed of two numbers separated by a dash) shown on your registration card or
which was e-mailed to you.

l Note down the identification number located on the license handler (this number is encrypted).
l Use a machine connected to the Internet and go to the Artlantis activation site at: http:/-

/activation.artlantis.com
l Once the activation page appears, enter the identification number that you had written down earlier then click on

the button "Connect to server".
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Serialization - Installing and activating network licenses

You will be issued with a license number that you will need to copy and paste in the Enter your Activation code
field of the license handler.

Start the Artlantis Keyserver* application located in the Artlantis folder that was installed.

NB: Artlantis KeyServer must be launched only on the server workstation. The server identification number
is activated only once on client workstations.
* In order for the client workstations to be able to use Artlantis, the Server must be activated and Artlantis Key-
Server launched. They can operate on the Artlantis server and Artlantis Keyserver at the same time.

Step 2: Install Artlantis on the client workstations.

l Make sure that Artlantis Keyserver is launched on the server.You can now launch Artlantis on the client sta-
tions.

l Click on Check Network to find an available key. If there is an available license on the server, the application
will be activated immediately.

Potential Problems

l If Artlantis prompts you for a serial number on a client workstation: Check that the computer is connected to the
local network. Check that the Artlantis Keyserver has been started on the server.

l On Servers with Windows XP in SP2 mode and with the Firewall activated.
l Click the unblock button when the Firewall shows that the Artlantis Keyserver or Artlantis is trying to use the

network.
l For another Firewall, ensure that port TCP 49151 is open.

NB: changing this setting does not affect the security of the Mac or the operation of other software.
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Opening 3DS Files

l Scale factor: reduces or enlarges object size. The scale factor is a homothetic coefficient.
l Converting cameras or lights: Imports lights and/or cameras defined in the original model.
l Translation: Redefines the position of the imported object relative to the scene's geometric tag.

NB: Artlantis imports material names, textures and fixed cameras.

Opening an Artlantis File
Either by:

Double clicking on an ATL or AOF file.

When the following dialog appears on opening a file, this means that one of the Medias associated with the project is
missing. Click on the missing element(s)

l Delete: permanently deletes the missing linked Media, it will no longer be requested when the document is
opened.

l Folder...: lets you browse the hard disk to find the folder containing the missing listed elements.
l Replace with...: allows the missing Media to be substituted by another.
l Continue: closes the dialog box and saves the options selected.
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Opening a File when the Application Launches

Open Recent

l Lists the last 10 Artlantis documents opened.

Open...

l Displays the dialog box for opening documents.

Artlantis files saved in a version earlier than 2.0 must be converted when they are opened. When this occurs, Art-
lantis displays a data conversion dialog:

Convert lamp power:
In version 1.2, lamp powers varied from 0.10 to 5,000. From version 2.1, the power varies from 1 to 1,000,000.

n Box checked: The lamp power values will be readjusted according to the new 1 to 1,000,000 scale. If you use
the digital field to set the value beyond that, the power values will not be replaced.

n Box unchecked: Lamp power values are retained. Note: the lamps will not have the same intensity.

The neon Shaders are not activated, so they will not take part in the lighting of the scene:
By default, the neon Shaders in version 1 will be deactivated. You can activate them using the viewpoint inspector
drop-down menu.

Replace current background with natural sun and sky:

n Box checked: The sky and sun replace the background defined in version 1.2.
n Box unchecked: The version 1.2 background is not changed.

Activate infinite ground:

n Box checked: An infinite ground will be placed at an altitude of 0. The altitude setting will be made in the Object
inspector.

n Box unchecked: No infinite ground. However, infinite ground may be activated in the Object inspector.
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Quit

l Closes the program without opening any document.

Drag/Drop a file to the Artlantis icon

NB: Artlantis also reads the old OPT/DB file formats produced by Artlantis 4.0

Opening DWG/DXF Files

l Scale factor reduces or enlarges object size. The scale factor is a homothetic coefficient.
l Curve segmentation value: The number of stops needed to define a curve or a circle entity.
l Import closed contour: Considers closed edges to be the same as surfaces.
l Block treatment: Interprets the block's material based on the following:

n Its composition
n Its instantiation
n Its name
n A distinct block has a distinct material.
n Each component of a given block has a distinct material.
n A distinct material is attributed to each block name.

l Allocating materials: To be defined either depending on the colors or the block layers.

NB: Artlantis recognizes the ACIS 3DSolid entities of AutoCad dwg and dxf files. Artlantis imports material
names and fixed cameras.

Opening DWF Files

l Scale factor reduces or enlarges object size. The scale factor is a homothetic coefficient.
l Coordinate system:
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n Convert from up-axis: The height is defined in the modeler according to the depth of the Y axis or the
height of the Z axis.

n Convert from handedness: Right or left, viewed from above, changes the object's symmetrical view.

l Use units and coordinate system settings: import the file with the standard settings.

NB: Artlantis imports material names and textures.

Opening OBJ Files

l Scale factor reduces or enlarges object size. The scale factor is a homothetic coefficient.

l Coordinate system:
n Convert from up-axis: The height is defined in the modeler according to the depth of the Y axis or the

height of the Z axis.
n Convert from handedness: Right or left, viewed from above, changes the object's symmetrical view.

NB: Artlantis imports material names and textures*.
* You must also generate an MTL file when importing textures. The OBJ and MTL files must be side by side when
importing.

Opening FBX Files

l Scale factor reduces or enlarges object size. The scale factor is a homothetic coefficient.

l Coordinate system:
n Convert from up-axis: The height is defined in the modeler according to the depth of the Y axis or the

height of the Z axis.
n Convert from handedness: Right or left, viewed from above, changes the object's symmetrical view.

NB: Artlantis imports material names, textures, light sources and fixed cameras.
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Using Reference Files

File Menu > Use Reference File...

This command lets you:

l Refer to a previously created .atl file in order to recover Shaders, Lights, Heliodons, Objects, Perspectives,

Parallel Views, Panoramas, VR Objects or Animations as desired.
l Update the geometry and materials between the modeling software and Artlantis.

In the dialog box, check the elements to be recovered from the reference file: Shaders, Lights, Heliodons, Objects,
Perspectives, Parallel views, Panoramas, VR Objects, Animations.

Example of Updating Geometry*:

Let us assume that you need to add a door to a document named "A.atl" that is dressed, lighted, etc.

Steps:

1. Save the current A.atl document.
2. Return to the modeler and add the door. Export the file again and rename it B.atl.
3. Open the B.atl file in Artlantis. Select Use Reference File... from the File menu and select the reference file A.atl

in the dialog box.

Artlantis will apply the checked options from file A to file B, i.e. Shaders, Lights, Heliodons, Objects, Per-
spectives and Parallel Views.

NB: for files from modelers which export in file formats DWG, DXF, 3DS, FBX, OBJ, DWF or SKP, you
must first save the files in .atl format.

NB: limitations to the Use reference file... command :
1 - if a material has been renamed or reassigned, it will not be included
2- if a part of the geometry has been saved as an object, the destroyed geometry will reappear
3- if the Artlantis layers containing the geometry of the scene are renamed, the geometry they contain will not be
included.

NB: * the CAD software ArchiCAD and Vectorworks allow you to directly update an atl file already worked
on in Artlantis. Please refer to the documentation for the software involved.
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Saving a Document

Artlantis saves in the following file formats:
ATL: The working document.
AOF: Format for scenes, as well as objects.
Archive : Contains all elements of a project.
DWF: The vector graphics file format for AutoCAD 2D and 3D.
OBJ: Wavefront file format.
SKP: SketchUp file format.

In this chapter you will learn about the following subjects:

Saving an ATL Document 19
Saving an AOF Document 19
Saving a DWF Document 20
Saving an OBJ Document 20
Saving an SKP Document 20
Saving an Archive 21

Saving an ATL Document
Saves the current Artlantis document to your file system. If you try to close an unsaved document, or you attempt to
quit Artlantis when an unsaved document is open, Artlantis will warn you to save your work before continuing.
File > Save

NB: Saved documents will no longer be compatible with earlier versions.

Saving an AOF Document
Saves the entire active scene as an .aof object. Does not replace or close the file you are currently working on.

NB: The origin of the created object is similar to the Scene origin, to modify See "Transfer the origin of the
anchor point:" page 132

l Select File > Export as Object...

1. Include light group:
l Choose the light group you wish to save with the object. This group will be automatically integrated

into the project concerned.
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2. Object positioning:
l Always vertical regardless of the surface to which it is applied (for example, a vehicle).
l Perpendicular to support on which it is placed.

Saving a DWF Document
Saves the whole active scene in DWF format. Does not replace or close the file you are currently working on.

l Select File > Export...> DWF.

Saving an OBJ Document
Saves the whole active scene in OBJ format. Does not replace or close the file you are currently working on.

l Select File > Export...> OBJ.

Saving an SKP Document
Saves the whole active scene in SketchUp format. Does not replace or close the file you are currently working on.

l Select File > Export...> SketchUp.
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Saving a Document - Saving an Archive

Saving an Archive
Saves the current document in the folder that groups all of the elements pertaining to the active document: *.atl files
and media folders: Shaders, Objects and Images and an ArchiveReport.txt file. This is a useful function for users to
share their projects.
File > Export as Archive...
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Artlantis Interface

General Information
By default, the Artlantis menu bar, the inspector navigation palette and the Preview window appear when the pro-
gram is started up.
The following other elements can be called up: General Preferences, the 2D View window, theMedia Catalog, the
Timeline and the Batch Rendering window.
Place the cursor over the palettes and window commands to display pop-up help bullets.
You can drag and drop Objects, Shaders, Textures and Background Images from the catalog or directly from the
hard drive to the Preview window.

Placement of Artlantis Palettes and Windows

1. Menu bar
2. Document preparation palette(dockable palette)
3. Navigation tools palette (dockable palette)
4. Artlantis tools palette (dockable palette)
5. Viewpoint and layer selector (dockable palette)
6. Inspector palette
7. Viewpoints List
8. Preview
9. 2D View Window
10. Catalog (dockable palette)
11. Timeline (dockable palette)

In this chapter you will learn about the following subjects:

Navigation Inspector 24

Page - 23



Chapter 5

The Artlantis Menus 25
File Menu 25
Edit Menu 26
Display Menu 26
Inspector Menu 28
Window Menu 29
Tools Menu 29
Help Menu 29

The 2D View Window 29
Editing in 2D View 30
Fixed Images 30
Animations 30
2D View Display and Navigation Tools 30
Customizing the 2D View Toolbar 31
Editing in 2D View 31

Editing the Clipping Box 73
In 2D View 73
Preview Representation 74
The Preview Window 74
Preview Display and Navigation Tools 75
Customizing the Preview Toolbar 76

The Timeline Window 77
Introduction: 77
Display 77
Animating 77
The Timeline window is divided into the following four areas: 78

Keyframes and Guides 81
Keyframes 81
Guides: 85

Navigation Inspector
Enables the user to edit viewpoints and animations, to configure model dressing, apply lighting effects and integrate
the project into its environment.
The behavior of certain mouse and keyboard shortcuts is dependent on the current Inspector.
The Inspector is a detachable palette, Ctrl + click at the top of the palette. To move it, click at the top of the window.
To re-insert into the window, drag it to the left-hand part of the window.

The following nine inspectors are available:

Shaders
Lights
Heliodons
Objects
Perspectives
Parallel Views

Panoramas

VR Objects

Animations
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Activation and changing from one Inspector to another: either via the Inspectormenu, or via the document prep-
aration toolbar available in the toolbar.

l Click on the desired Inspector (e.g. Heliodon in the figure below).

l To navigate between viewpoint and animation inspectors, click on the arrow on the right.

The Artlantis Menus
Use the menu bar to access the following commands: file management, display, navigation among the various edit
modes, managing window opening and closing, and online help.

In this chapter you will learn about the following subjects:

File Menu 25
Edit Menu 26
Display Menu 26
Inspector Menu 28
Window Menu 29
Tools Menu 29
Help Menu 29

File Menu

Contains the commands for managing documents (opening, saving and printing).
Open...
Saved Artlantis *.atl document. This command will directly open files in the following formats: atl, aof, opt/db, dwg,
dxf, dwf, obj, fbx, skp and 3ds.

NB: Artlantis recognizes the ACIS 3DSolid entities of AutoCad dwg and dxf files.

Keyboard Shortcut:  Ctrl O
Merge Geometry from File...
A file currently opened can be merged with another file: atl, aof, opt/db, dwg, dxf, dwf, obj, fbx, gs1, skp and 3ds.
Save
Saves the current Artlantis document to your file system. If you try to close an unsaved document, or you attempt to
quit Artlantis when an unsaved document is open, Artlantis will warn you to save your work before continuing.

NB: Saved documents will no longer be compatible with earlier versions.

Keyboard Shortcut:  Ctrl S
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Save As...
Opens the Save As dialog box, pointing to the current folder. You can save the current file as a new document. (Ena-
bles the user to rename the file and save it to a different folder). The new file becomes the active document.
Reverts to the saved version
Active document when it was last saved.
Export as Object...

Saves the entire active scene as an ".aof" object. Does not replace or close the file you are currently working on.
Export as Archive...

Saves the current document in the folder that groups all of the elements pertaining to the active document: *.atl files
and media folders: Shaders, Objects and Images and an ArchiveReport.txt file. This is a useful function for users to
share their projects.
Export…
Exports the geometry of the current document in OBJ, SKP or DWF format.
Use reference file...
Recovers all or part of the elements from a different .atl file into the current file. This can import shaders, lights, hel-
iodons, objects and cameras from Perspective and Parallel views.

Edit Menu

Standard commands for handling files: Undo/Redo/Cut/Copy/Paste/Erase/Preferences.
Undo
Undoes the last command. Also allows the user to step backwards, undoing all operations performed since the doc-
ument was opened. The number of operations that can be recovered is limited only by the amount of memory avail-
able. The command's heading shows what action is undone and applies to the active window. Redo is the opposite
operation of Undo.

Keyboard Shortcut: Ctrl Z
Redo
Reverses the last Undo command and displays the action to be redone in the heading.

Keyboard Shortcut: CTRL Shift Z
Cut
Works in numeric fields and inspector lists.The cut element is stored in the clipboard. Clipboard contents are retained
until the next Cut/Copy operation is performed.

Keyboard Shortcut:  Ctrl X
Copy
This command works in digital fields and inspector lists.The element copied is stored in the clipboard. Clipboard con-
tents are retained until the next Cut/Copy operation is performed.

Keyboard Shortcut:  Ctrl C
Paste
Pastes the contents of the clipboard into inspector lists and numeric fields. Clipboard contents are retained until the
next Cut/Copy operation is performed.

Keyboard Shortcut:  Ctrl V
Delete
Removes the items selected in inspector lists, numeric fields, and objects in the scene.
Preferences
Defines the program's overall behavior.

Display Menu

The project's display commands are in the active view (Preview window, 2D View window).
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Enlarge/Reduce

l In the Preview window
Factor of x1.5 from center. Sizes are to be defined in the Artlantis Preferences. Maximum size 1200x1200,
minimum size 640x640.

l In the 2D View window
Factor of x1.5 from center.

Keyboard Shortcut: Enlarge + and Reduce -
Fit to Window

l In the Preview window
Fit the view to the window size.

l In the 2D View window
Instantly displays all elements of a project.

Keyboard Shortcut: =
Back to Original View
Returns to the viewpoint present when it was activated.
Zoom
Acts the same way in the Preview and 2D View windows except that, in Preview, the camera target and the focus are
recomputed.

l Zoom + click in the window enlarges the view x2 from the point clicked.
l Zoom + click, followed by dragging and dropping into the window enlarges it in relation to the center of the

rectangle.

To zoom out, press the Alt key before clicking or describing the limiting box. The tool deactivates when the command
is finished.

NB: In Windows, only the 2D View is affected.

Pan
Drag and drop to move the content to the appropriate window. The tool deactivates when the command is finished.
The camera target is recalculated for the Preview window.

NB: In Windows, only the 2D View is affected.

Holding down the middle button on the mouse produces the same effect.
Change 2D View
Replaces the current projected view with a different one: Top, front, right, left or back.

Keyboard Shortcut: Ctrl 1, 2, 3, 4 or 5
2D View Display
Enables the user to change the type of display: Wireframe or Textured mode.
Back
In 2D view, this enables the user to navigate by back-stepping upwards through the sequence of views displayed in
the tree structure.

Keyboard Shortcut: Ctrl <
Next
In 2D View, this enables the user to navigate downwards through the sequence of views displayed in the tree struc-
ture.

Keyboard Shortcut: Ctrl >
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Hide Toolbar
Displays/hides the bar for the view active in Preview or 2D View.
Status Bar
Displays/hides the bar and provides information on the display progression in the Preview window.
Toolbars
Displays/hides the command groups belonging to the bar in question: Prepare Document, Navigation Tools, Artlantis
Tools, Viewpoint Selector, Radiosity box, Show Text and Lock Toolbars.

Inspector Menu

Contains the inspectors for views (perspectives, parallel views and cuts), lighting effects (lights and heliodons), scene
dressing (shaders, textures and objects), and environment (background and foreground images, insertion to site,
depth of field, atmosphere and ambient).

NB: It is not always necessary to change the edit inspector to modify a project. There are sufficient com-
mands available, regardless of which inspector is active.

Perspectives
Displays the Perspectives inspector.
Parallel Views
Displays the Parallel View inspector.
Panoramas
Displays the Panoramas inspector.
VR Objects
Displays the VR Object inspector.
Animations
Displays the Animations inspector.
Shaders
Displays the Shader inspector.
Lights
Displays the Lights inspector.
Heliodons
Displays theHeliodon inspector.
Objects
Displays theObject inspector.
Render
Displays the Render Window for defining rendering options and format, as well as destination.

Keyboard Shortcut: Ctrl R
Partial render

In the Preview window, draw a rectangle by dragging across two opposite corners to define the area you wish to
render. The rendering appears in a new window. The Save Image dialog box appears when you close the rendering.

Keyboard Shortcut: Ctrl Shift R
Batch Rendering...

This window handles the status, destination and format of batch renders that have been defined in advance using the
Render command.
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Window Menu

Contains the window activation commands: 2D View, Catalog and Timeline.
Inspector
Displays/hides the Inspector palette
2D View
Displays the 2D View window: Top, front, right, left or back.
Catalog
Displays theMedia Catalog.
Timeline
Displays the Timeline.
Rendering Parameters
Displays the rendering settings dialog.
Scene information:
Displays the scene settings dialog .

Tools Menu

Create Shader
Opens the Edit Shader dialog
Create a Postcard™
Saves the current view as a Postcard™

Help Menu

Artlantis Help
Online Artlantis documentation containing reference information on each of the program's functions, plus detailed
illustrated tutorials.

Keyboard Shortcut: F1
Artlantis Web Site
Opens your Web browser to the Artlantis page of the Abvent site by default: The English language Artlantis
forum, product information, updates, FAQs, training, etc.
Tutorials
Displays the tutorials page in the help window.
Additional Media
Displays additional media available on the Artlantis Web site
Online registration...
Lets you register the product directly on the Abvent site. Fill out the form displayed then confirm.
Edit License
Displays the License activation manager.
About Artlantis
Shows the version number.

The 2D View Window
This is used for viewing and editing the project in the following five projected views: Top, front, right, left or back.
View display is independent of the current inspector. Example: In the Perspectives inspector, you can edit lights in
2D View without activating the Lights inspector.
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2D View Display and Navigation Tools
Customizing the 2D View Toolbar
Keyboard and Mouse Shortcuts

Editing in 2D View

Right clicking on the element you wish to edit displays a pop-up menu for the current operations: Duplicate, Delete,
Attribute To, etc. These are performed in real time in the Preview window and in the relevant inspectors.

Fixed Images

Working with Objects in 2D View
Working with Parallel Views in 2D View
Working with Perspectives in 2D View
Working with Lights in 2D View
Modifying Heliodons
Working with the Clipping Box in 2D View

Animations

Working with Panoramas in 2D View
Working with VR Objects in 2D View

Working with Panoramas in 2D View

2D View Display and Navigation Tools

Default Tools Available

Previous and Next: Used for moving between displays.

Fit to Window: Maximizes the display of all of the geometry and lights to the full size of the window.

Zoom: Increases the zone defined by a rectangle. Alt+Zoom reduces the display.

Pan: Reframes the content of the window.

Change View: A drop-down menu for selecting the projected view.
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Edit Path: In animation mode, is used for creating or modifying a path relative to a camera, a light or an
object.

Customizing the 2D View Toolbar

The following tools are available by right clicking on the bar:

l To add or delete tools, select them from the "Available buttons" or "Toolbar Buttons" columns. You can use
drag and drop between these two columns.

Display mode: Switches from wireframe to textured display.

Editing in 2D View

In this chapter you will learn about the following subjects:

Working with Perspectives in 2D View 32
Working with Parallel Views in 2D View 34
Working with Objects in 2D View 36
Working with Lights in 2D View 38
Editing Heliodons 42
Working with the Clipping Box in 2D View 44
Working with VR Objects in 2D View 45
Working with Panoramas in 2D View 49
Working with Camera Animation in 2D View 52
Working with Light Animation in 2D View 60
Working with Object Animations in 2D View 66
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Working with Perspectives in 2D View

Display Wireframe Mode State or Action Comments

Viewpoint inactive Represented by the cam-
era (gray point).

Active viewpoint selected. Represented by the camera
(red point), the target (gray
point), the focusing angle
(blue lines) and the angle's
bisector line (gray line).

l Move the camera. l Move the red point.

l Move the target. l Move the gray point.

l Move the camera in a
parallel direction.

l Move the gray bisect-
ing line.

l Change the focusing
angle.

l Move one of the two
blue lines.

l Duplicate viewpoint l Press ALT and move
the camera (red
point).

or

l Right click on the
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or Duplicate" in the
pop-up menu.

l Delete viewpoint l Right click on the
camera then select
"Delete" in the pop-
up menu.

l Edit an active light
with this viewpoint.

l Right click on the
camera (red point).
In the pop-up menu,
choose "Edit Light",
select the name of
the light.

NB: The inspector pal-
ette switches from Per-
spectives mode to Lights
mode.

l Edit an Active Hel-
iodon with this View-
point.

l Right click on the
camera (red point)
then select "Edit Hel-
iodon" in the pop-up
menu.

NB: The inspector pal-
ette switches from Per-
spectives mode to Heliodons
mode.
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Working with Parallel Views in 2D View

Display Wireframe Mode State or Action Comments

Viewpoint inactive Represented by the camera
(gray point).

Active viewpoint selected. Represented by the camera
(red point), the target (gray
point), the width of view
(red lines) and the symmetry
axis linking the camera and
the target (gray line).

l Move the camera. l Move the red point.

l Move the target. l Move the gray point.

l Move the camera in a
parallel direction.

l Move the gray sym-
metry axis.

l Define the view area. l Move one of the red
lines.
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or

l Duplicate the view-
point

l Press the ALT key
then move the cam-
era (red point), tar-
get (gray) or the
symmetry axis
(gray).

or

l Right click on the
camera then select
"Duplicate" in the
pop-up menu.

l Delete viewpoint l Right click on the
camera then select
"Delete" in the pop-
up menu.

l Add to Viewpoints
List: Perspectives, Pan-
oramas, VR Objects or
Sequences

Right click on the camera
then select "Add To List..."
in the pop-up menu.

l Edit an Active Hel-
iodon with this View-
point.

l Right click on the
camera (red point)
then select "Edit
Heliodon" in the
pop-up menu.

NB: The inspector pal-
ette switches from the Par-
allel View mode to
Heliodons mode.

l Edit an active light
with this viewpoint.

l Right click on the
camera (red point).
In the pop-up menu,
choose "Edit Light",
select the name of
the light.

NB: The inspector pal-
ette switches from Parallel
View mode to Lights mode.
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Working with Objects in 2D View

Display Wireframe Mode State or Action Comments

Object deselected Represented by the geometry
and a green center point.

Selected object Represented by the geometry
and a blue center point.

l Move an object. l Move the blue point if
the object is active or
green point if it is inac-
tive.

l Duplicate an Object. l Press Alt and move blue
or green point.

1

2

3

l Multiple duplication of
an object

1. Press Shift+Alt keys and
draw out a (green) line.

2. Hit the "plus" key to
indicate the number of
copies (pink points).
Press the "minus" key to
remove them.

3. Confirm by hitting
Enter.

1

2

Make Multiple Duplicates of
More than One Object.

l Select the objects:
l Ctrl+click the objects

1. Press Shift+Alt keys and
draw out a (green) line.

2. Hit the "plus" key to
indicate the number of
copies (pink points).
Press the "minus" key to
remove them.

3. Confirm by hitting
Enter.
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3

Use as camera target/Do not
use as camera target for an
animation or perspective
view

Redefine the anchor point of
an object

l Select the object, press
D then in 2D View drag
the object's blue anchor
point.

This works for internal or
external object).

The multiple duplication of
objects follows the topology of
the geometry. Example: a tree
duplicated along a path on a
hill will follow the different
heights of this hill.

Once duplicated, the new
trees follow the topography.

NB: Objects are deleted from the inspector list.
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Working with Lights in 2D View

Display Wireframe Mode State or Action Comments

Deselected light is off Represented in shaded yellow.

Selected light is off Represented in shaded yellow cir-
cled in black.

Deselected light is on Represented in bright yellow with
thin black circle.

Selected light is on Represented in dark orange with
thick black circle.

l Move a light Move the yellow point(s) depend-
ing on the type of light.

l Turn On/Off Turn current light on/off.

NB : Selecting more than
one light enables you to turn them
on/off at the same time.

l Duplicate a light. l Hit the Alt key to move the
yellow point.

or

l Right click on the yellow
point and select "Duplicate"
in the pop-up menu.

NB: The duplicated light
retains the parameters of the ref-
erence light (power, shadows, etc.).
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1

2

3

l Multiple duplication
of a light

1. Press Shift+Alt keys and
draw out a (green) line.

2. Hit the "plus" key to indi-
cate the number of copies
(pink points). Press the
"minus" key to remove
them.

3. Confirm by hitting Enter

1

l Make multiple dupli-
cations of more than
one light

l Select lights belonging to
the same group:
Ctrl+click the lights.

1. Press Shift+ALT keys and
draw out a (green) line.

2. Hit the "plus" key to indi-
cate the number of copies
(pink points). Press the
"minus" key to remove
them.

3. Confirm by hitting Enter

NB: The duplicated lights
retain the parameters of the ref-
erence light (power, shadows, etc.).
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2

3
l Cut a light Deletes the current light, but

holds it in memory so it can later
be pasted into a light group from
the lights list. (To paste into the
lights list, right click on the name
of a group and select Paste).

l Copy a light Copy the current light without
deleting it. It is held in memory
so it can later be pasted into a
light group on the lights list. (To
paste into the lights list, right
click on the name of a group and
select Paste).

NB: Selecting more than
one light enables you to copy
them at the same time.

l Delete a light l Right click on the light then
select "Delete" in the pop-
up menu. The light is
deleted. To recover the
light, go to Edit > Undo
Delete Lights

l Edit a view using this
light.

l Right click on the light. In
the pop-up menu, choose
"Edit View Using This
Light". Select the name of
the view.

NB: The inspector palette
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switches from the Lights mode to
Viewpoints mode (Perspectives or
Parallel Views).

Page - 41



Chapter 5

Editing Heliodons

Sun Position Display Wireframe Mode State or Action Comments

Position the
sun based on
the geo-
graphical
location, date
and place Orientation

True North (compass
point).

l Setting the orientation
of North

l Pivot the yellow point
around the compass.
The yellow arrow
will move accord-
ingly around the cir-
cle.

The rays of the sun
(yellow lines with
arrow points) are
positioned depending
on the location, true
North and the date
and time.

NB: Use the
Heliodons inspector
to configure these ele-
ments, except for true
North.

Shadows are then
recomputed in the
Preview window.

Manually
move the
sun.

l Manually positioning
the sun.

Shadows are then
recomputed in the
Preview window.
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Limit the
sun to
alwayscast-
ing shad-
ows at 45°
depending
on view-
point posi-
tion.

l Graphically moving
the viewpoint redi-
rects shadows cast to
45°.

Shadows are then
recomputed in the
Preview window.
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Working with the Clipping Box in 2D View

Wireframe Display Mode State or Action Comments

Limiting box Represented by a blue cross-
hair and rectangle.

l Click/drag inside
the box to move
it.

l Resize Clipping
Box

Move the blue points located
at the corners.

l Turn Clipping
Box

Turn the blue handle of the
crosshair around its center.

Move the center of the cross-
hair to redefine the axis of
rotation

Elevated view Editing operations are the
same as in plane view, except
that the box does not pivot.
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Working with VR Objects in 2D View

Wireframe View on Plane Mode Display

Hemispherical

Toric

Spherical

Wireframe
View in
Elevation

Mode Display
mode

State or Action Comments

VR object dese-
lected

Represented grayed by the
target and a circle.

VR object
selected.

Top view: represented by
the camera (gray dot on
the circle), the target (cen-
tral red dot).

The camera moves around
the blue circle. The focus
opening angle is defined by
the two blue lines and the
angle bisector (gray line).

In Elevation: The target
point is red. Two gray
points linked by a shaded
line represent the camera
altitude.

The small red points on the
circle represent the cam-
era movement pitch (pitch
value dissociated in top
and elevated views).

or

l Move VR
objects.

Top view:

l Move the target in
red, or the bisector
in gray.

In Elevation:

l Move the target in
red or the shaded
horizontal line.
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l Move the
camera.

Top view:

l Move the gray point
in the blue circle.

In Elevation:

l Adjust the camera
height by moving
the shaded hor-
izontal line that
runs through the
two gray points.

NB: In these views,
the camera position defines
the starting image when the
VR objects are read.

N/A l Change the
focusing
angle.

l Move one of the
two blue lines.

N/A Angle Opening
Constraint

l Lock posi-
tion of VR
object start-
ing angle.

Indicates the starting posi-
tion of the angle opening
relative to 0° in a trig-
onometric circle.

l Pivot the blue
radius around the
red point in the
center. This
changes the con-
straint value in the
VR Object/Co-
ordinates inspector.
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N/A l Limit VR
Object Open-
ing Angle
Horizontally.

Enter an angle value of
<360° in the VR Object/Co-
ordinates inspector.

Once open, the circle can
be edited graphically.

The opening angle value
depends on the Constraint
angle value.

+

Same as
plane view

l Duplicate
VR
Object.

l Press ALT and
move the camera
target in red..

or

l Right click on the
camera then select
"Duplicate" in the
pop-up menu.
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or

Same as plane
view

l Delete VR
Object.

l Right click on the
camera then select
"Duplicate" in the
pop-up menu.

Same as plane
view

l Edit Light
active with
this VR
Object.

l Right click the red
target. In the pop-up
menu, select "Edit
Light", select the
name of the light.

NB: The inspector pal-
ette switches from VR Object
mode to Lights mode.

Same as plane
view

l Edit active
Heliodon
with this VR
Object.

l Right click on the tar-
get in red and select
"Edit Heliodon" in
the pop-up menu.

NB: The inspector pal-
ette switches from VR Object
mode to Heliodons mode.
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Working with Panoramas in 2D View

Wireframe Display Mode State or Action Comments

Node deselected Indicated by the camera (gray
dot) and the horizontal or vertical
viewpoint movement circle.
Viewpoint active.

Node selected Represented by the camera (red
point), with the target (blue) mov-
ing in a circle (blue circle), the
focus angle (blue lines) and the
angle's bisector line (red line).

l Move the
viewpoint.

l Use the red point for this.

l Move the
target.

l Move the blue point in the
blue circle.

NB: The target point posi-
tion defines the starting image
when the panorama is read.
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l Move the
node in a
parallel
direction.

l Move the red bisecting
line.

l Change the
focusing
angle.

l Move one of the two blue
lines.

+

or

l Duplicate
the node

l Press ALT and move the
camera (red point)

or

l Right click on the camera
then select "Duplicate" in
the pop-up menu.

l Delete the
node

l Right click on the camera
then select "Delete" in the
pop-up menu.
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l Edit Light
active with
this view-
point.

l Right click on the camera
(red point). In the pop-up
menu, choose "Edit Light",
select the name of the light.

NB: The inspector palette
switches from the Panorama mode
to Light mode.

l Edit active
Heliodon with
this view-
point.

l Right click on the camera
(red point) then select "Edit
Heliodon" in the pop-up
menu.

NB: The inspector palette
switches from Panorama mode to
Heliodons mode.

l The selected
node becomes
the first node;
this is the
first one
played when
playing the
panorama.

l Right click on the node of
the panorama select "Make
First Node". When the node
is already the first node a
disabled "Is First Node" is
displayed.

l How to
define a new
direction?

l Click and move around, turn
the red arrow tip to define
the new direction of the
node, all the direction of the
other nodes will become
affected. Only the first
node is defined with a red
arrow.

l When the panorama is
played, this view is dis-
played by default.
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l How to
create a link
between two
nodes.

l Click in the blue circle
node, hold the mouse button
down and drag the cursor in
the blue circle of the node
to connect. A green arrow
is drawn between the two
nodes.

l How do you
delete a link
between two
nodes?

l To delete a link between
two nodes. Click on the link
to select it, it turns green,
then make a right click on it
and choose Delete.

Working with Camera Animation in 2D View

2D View Window

Path edits are clearly distinguished from keyframe edits.
This concerns the paths for cameras, lights, and objects as well as the relevant pop-up menus.
Editing Paths

Camera path is in red.
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NB: Camera target points can be edited graphically at any time, regardless of whether record mode is on or
not.

Use the Edit Path tool in the window bar to select the mode.

l Button pressed: Path editor is active (As a result, editing the keyframe in the view is inactive).

l Button raised:  Keyframe editor is active (As a result, the path is visible but cannot be edited).
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Create Path

l In mode, move the camera viewpoint.
l This draws a red path in a straight line.

l White dots circled in gray indicate start and end points that have tangents.
l The tangent handles are indicated by red dots circled in black.

Move Path

l Click on the path and move it.

Editing the Path

l Use the handles to graphically edit the tangents.

Add a Control Point

l Right clicking on the red path line and selecting "Add Control Point" displays a gray circle and a tangent with
two editing handles.
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To edit a portion of the tangent at a point

l Right click on the point and select "Unlock Tangent" to create an inflection point on the path.
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To delete the inflection point

l Right click on the point and select "Lock Tangent".

Extend Path
Extends the path without touching the existing animation.

l Alt+Click on the last control point created for the path.
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l Creates a new control at the end of the path.

NB: The timeline can be used to play the sequence at any time.

Path Edit Pop-up Menu

l Right clicking on the red path displays a pop-up menu with the following options:

l Add Control Point: adds an editable point to the path.
l Delete Control Point: deletes the point from the path (except the end points).
l Close Path: closes the path on itself.
l Open Path: re-opens the path.
l Delete Path: deletes the path.
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Editing Keyframes

Camera path is in red.

NB 1: You must be in record mode in order to edit in the Timeline.

Keyframe Edit Pop-up Menu:

l Add Keyframe: adds a keyframe.
l Delete Keyframe: deletes a keyframe

Add a keyframe

l In mode, button is raised (not active).

l In the Timeline window, click on record in 2D view, right click the path, select "Add key frame" from the
pop-up menu.

This creates the keyframe.
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The keyframe can be moved graphically on the path, making it possible to speed up, slow down, etc.

NB: A keyframe selected in 2D View appears with a red pin on the Timeline. A pause can be created in the
movement of the element by duplicating a keyframe in the Timeline.

NB 2: When editing or reading a sequence, the Preview window displays the content in OpenGL Navi-
gation mode if "Automatic Switch to OpenGL" has been checked in the preferences.

The 2D View Edit Filters Pop-up Menu:
This displays and/or hides paths in order to improve editing in 2D View.

l Right clicking on the white background of the 2D window displays the following pop-up menu that makes it
easier to edit in 2D View, as well as display and hide paths.

l Show All: displays all camera, light and object paths.
l Show only current type elements: Depending on which inspector is active (Animations, Lights or Objects), dis-

plays all camera, light or object paths.
l Show Only Current Element: displays only the path currently being edited.

Viewpoint Edit Pop-up Menu:
Regardless of whether the user is in path or time edit mode, right clicking on a camera's target or one of the blue lines
that represent the focus opening will display a pop-up menu with the following options:

l Duplicate: duplicates the sequence; the current camera position becomes the default view and the path is not
duplicated. Uses the original to create a new superimposed viewpoint.

l Add to: Perspectives View List:
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l Add to: Parallel Views list
l Add to: Panorama list
l Add to: VR Object List

Depending on option selected, adds current view from Perspectives to Parallel Views, Panoramas, or VR Objects.

l Edit Light Activated With This Viewpoint :
Choose a light. The inspector palette switches to Lights mode and the light is selected.

l Edit Heliodon Activated With This Viewpoint:
The inspector palette switches to Heliodons mode and the heliodon is selected.

l Delete: The viewpoint is removed from the list.

Working with Light Animation in 2D View

2D View Window:

Path edits are clearly distinguished from keyframe edits.
This concerns the paths for cameras, lights, and objects as well as the relevant pop-up menus.
Editing Paths

The light path is in yellow.

Use the Edit Path tool in the window bar to select the mode.

Button pressed:  Path editor is active (As a result, editing the keyframe in the view is inactive).
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Button raised:  Keyframe editor is active (As a result, the path is visible but cannot be edited).

Create Path

l In mode, move the light source.
l This draws a yellow path in a straight line.

l White dots circled in gray indicate start and end points that have tangents.
l The tangent handles are indicated by red dots circled in black.

Move Path

l Click on the path and move it.
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Editing the Path

l Use the handles to graphically edit the tangents.

Add a Control Point

l Right clicking on the yellow path line and selecting "Add Control Point" displays a gray circle and a tangent
with two editing handles.

Result.
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To edit a portion of the tangent at a point:

l Right click on the point or on an "Unlock Tangent" item handle to create an inflection point in the path.

Result.

To delete the inflection point

l Select "Lock Tangent".
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Result.

Extend Path
Extends the path without touching the existing animation.

l Alt+Click on the last control point created for the path.

NB: The timeline can be used to play the sequence at any time.

Page - 64



Artlantis Interface -  The 2D View Window

Path Edit Pop-up Menu

l Right clicking on the yellow path displays a pop-up menu with the following options:

l Add Control Point: adds an editable point to the path.
l Delete Control Point: deletes the point from the path (except the end points).
l Close Path: closes the path on itself.
l Open Path: re-opens the path.
l Delete Path: deletes the path.

l Right clicking on a control point or tangent handle displays a pop-up menu with the following options:

n Lock Tangent: to delete an inflection point.
n Unlock Tangent: to create an inflection point. This makes it possible to create an inflection point to

manipulate sections of the tangents independently.

Editing Keyframes

NB 1: You must be in record mode in order to edit in the Timeline.

Keyframe Edit Pop-up Menu:

l Add Keyframe: adds a keyframe.
l Delete Keyframe: deletes a keyframe.

Adding a key image

l In mode, button is raised (not active).

l In the Timeline window, click on record in 2D view, right click the path, select "Add key frame" from
the pop-up menu.
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This creates the keyframe.

The keyframe can be moved graphically on the path, making it possible to speed up, slow down, etc.

NB: A keyframe selected in 2D View appears with a red pin on the Timeline. A pause can be created in the
movement of the element by duplicating a keyframe in the Timeline.

NB 2: When editing or reading a sequence, the Preview window displays the content in OpenGL Navi-
gation mode if "Automatic Switch to OpenGL" has been checked in the preferences.

Keyframe Edit Pop-up Menu:
This displays and/or hides paths in order to improve editing in 2D View.

l Right clicking on the white background of the 2D window displays the following pop-up menu that makes it
easier to edit in 2D View, as well as display and hide paths.

l Show All: displays all camera, light and object paths.
l Show Only Current Type Elements: Depending on which inspector is active (Animations, Lights or Objects),

displays all camera, light or object paths.
l Show Only Current Element: displays only the path currently being edited.

Working with Object Animations in 2D View

2D View Window

Path edits are clearly distinguished from keyframe edits.
This concerns the paths for cameras, lights, and objects as well as the relevant pop-up menus.
Editing Paths
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Object path is in green.

l Use the Edit Path tool in the window bar to select the mode.

l Button pressed:  Path editor is active (As a result, editing the keyframe in the view is inactive).

l Button raised:  Keyframe editor is active (As a result, the path is visible but cannot be edited).
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Create Path

In mode, move the object.

l White dots circled in gray indicate start and end points that have tangents.
l The tangent handles are indicated by red dots circled in black.

This draws a green path in a straight line.

Move Path

l Click on the path and move it.

Editing the Path

l Use the handles to graphically edit the tangents.

Add a Control Point
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l Right clicking on the green path line and selecting "Add Control Point" displays a gray circle and a tangent with
two editing handles.

Result.

To edit a portion of the tangent at a point:

l Right click on the point or on an "Unlock Tangent" item handle to create an inflection point in the path.

Result.
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To delete the inflection point:

l Select "Lock Tangent".

Result.

Extend Path
Extends the path without touching the existing animation.

l Alt+Click on the last control point created for the path.
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Result.

NB: The timeline can be used to play the sequence at any time.

Path Edit Pop-up Menu

l Right clicking on the green path displays a pop-up menu with the following options:
n Add Control Point: adds an editable point to the path.
n Delete Control Point: deletes the point from the path (except the end points).
n Close Path: closes the path on itself.
n Open Path: re-opens the path.
n Delete Path: deletes the path.

l Right clicking on a tangent handle or control point displays a pop-up menu with the following options:
n Lock Tangent: to delete an inflection point.

or
n Unlock Tangent: to create an inflection point.

After unlocking the tangent, you can create an inflection point to work independently with half tangents.
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Editing Keyframes

Object path is in green.

NB 1: You must be in record mode in order to edit in the Timeline.

Keyframe Edit Pop-up Menu:
Right clicking on the green path displays a pop-up menu with the following options:

n Add Keyframe: adds a keyframe.
n Delete Keyframe: deletes a keyframe.

Add a keyframe

l In mode, button is raised (not active).

l In the Timeline window, click on record in 2D view, right click the path, select "Add key frame" from the
pop-up menu.

This creates the keyframe.
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The keyframe can be moved graphically on the path, making it possible to speed up, slow down, etc.

NB: A keyframe selected in 2D View appears with a red pin on the Timeline. A pause can be created in the
movement of the element by duplicating a keyframe in the Timeline.

NB 2: When editing or reading a sequence, the Preview window displays the content in OpenGL Navi-
gation mode if "Automatic Switch to OpenGL" has been checked in the preferences.

The 2D View Edit Filters Pop-up Menu:

l Right clicking on the white background of the 2D window displays the following pop-up menu that makes it
easier to edit in 2D View, as well as display and hide paths.

l Show All: displays all camera, light and object paths.
l Show Only Current Type Elements: Depending on which inspector is active (Animations, Lights or Objects),

displays all camera, light or object paths.
l Show Only Current Element: displays only the path currently being edited.

Editing the Clipping Box
This is a blue box with corner handles that can be edited.

l Activation and display in Viewpoint inspectors: Perspectives, Parallel Views, Panoramas, VR Objects and
Animations.

l Entering an angle value in degrees in the numeric field pivots the box within the plane.

In 2D View

Change the view (above, front, right, left or back) to define more than one clipping plane in the space (up to a max-
imum of six clipping planes).
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l Edit the blue handles to define the clipping planes.

Elements outside the blue box are excluded from the scene.
When viewing from above, the rotation angle can also be defined graphically in 2D View.

NB: When elements are clipped, the shadows projected are adapted.

Preview Representation

Example of a clipping box in Perspective view.

Inactive Clipping Box

Active Clipping Box

The Preview Window

The main working window. It displays the final rendering in real time before any calculation is initiated!
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Both the toolbar commands (Navigation, Zoom, Pan and Front View) and the Keyboard and Mouse Shortcuts spe-
cific to the Preview window are used to navigate within a scene.
Preview Display and Navigation Tools
Customizing the Preview Toolbar

Preview Display and Navigation Tools

Grouped by topic

Navigation tools:
Show/hide navigation bar in the project:

Activates and deactivates display in OpenGL mode. Useful for navigating within large databases.

NB: Shadows and lighting effects in OpenGL depend on the Preference settings.

Pan To: Positions the camera perpendicular to the surface clicked.

Back: Resets the camera to the position defined when the view was activated.

Zoom: Moves the camera (the zone in question is defined by a rectangle). The Alt+Zoom option moves the cam-
era backwards.

Pan: Pans the scene by moving the active camera.

Update: Saves the viewpoint position (viewpoint, target, focus distance and camera roll). This tool only works
when the Automatic Update option is not activated in the General Preferences.
Artlantis tools:
Display/hide the following toolbars:

Displays the 2D View window.

Catalog: provides access to Catalogs and Media (Shaders, Objects, Images and Postcards).

Render: Opens the dialog box for preparing and launching rendering.
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Partial Render: Within the scene, this initiates rendering of the zone bounded by the rectangle.

Rendering Parameters: Displays the rendering settings dialog.

Refine Preview: Radiosity display becomes close to end result.

Create Postcard: saves current viewpoint as a Postcard.

Radiosity: activates or deactivates radiosity.

Current layer: destination of an object when dragging and dropping an object in the
scene.

l If Auto is checked:
Drag and drop an object in the scene, this object will go into the layer appropriate to its type or into the active
layer if there is no default destination layer for this object type.

l If Auto is unchecked:
The popup menu for the layer shows the destination layer for an object during a drag-drop in the scene as
long as there is no default destination layer for this object type.

Viewpoint selector:
Show/hide the viewpoints drop-down menu bar:

Navigation in viewpoints.

Show/Hide Tool Group in the toolbar

l Right click on the toolbar, then choose an item:

Customizing the Toolbar

SpaceNavigator Peripheral Compatibility:

l Ergonomics: hardware compatibility with SpaceNavigator from 3D Connexion, a 3D navigation tool.
Lets you navigate through the scene and edit items in the scene using the mouse.

Customizing the Preview Toolbar

From Display menu > Toolbars > Customize...

To add or delete tools, select them from the "Available toolbar buttons" column or under "Current Toolbar Buttons".
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NB: if the Artlantis toolbar is not displayed, it is not possible to customize the preview toolbar.

The Timeline Window

Introduction:
Animation work is done using the Animations, Lights, Heliodons or Objects and the 2D View, Preview window
and the Timeline window.
The timeline enables the user to record, edit and play a scene. The scene is made up of sequences that are managed in
the Animations Inspector list.

Display

Activating the Animations inspector displays the Timeline window.
If the Timeline window closes again, click on the Animations inspector icon or go to Windows > Timeline.

Animating

Artlantis animates practically all commands relating to the inspectors:

l Cameras (animations)
l Lights
l Heliodons
l Objects
l Animated Textures

Begin as follows to animate the parameters for cameras, lights, heliodons, objects and animated textures:

1. Activate the Animations Inspector, then
2. Activate the Light, Heliodons, Object or Shaders inspector

Comment: The Timeline window will remain open to enable you to edit animation times.

NB: In 2D View, the Timeline and the appropriate inspector must remain open in order to create
and edit animated paths for lights, objects or cameras.
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The Timeline window is divided into the following four areas:

1. Title Bar: Shows the name of the current sequence.
2. Time scale : Gives duration of the scene with a slide bar and cursor for positioning and editing keys and

sequences.
3. Recorder : Controls recording and playback of animations.
4. Sequence Duration Control: Used for editing the duration and rate of images.

Title Bar

Name of the current sequence, as defined in the animations list. The timeline updates relative to
the current sequence (blue band). The other sequences in the scene (gray bands).

Time scale

The slide bar is the time scale that shows the total time in the scene. The time runs from left to
right.
The cursor shows the current scene time at instant T.

NB: The current position also displays in 2D View, if the element is animated on a path.
Click and drag to move the cursor. The cursor is blue. When a keyframe passes, it sticks to the
pin and becomes red.
The cursor moves away from it when:
• The time is edited
• The current sequence is played.
• The mouse wheel can be used to zoom on the scene when rolling over the time scale.

Time scale zoom cursor: Enables the user to show the entire scene or focus on
just a portion of it.

Current sequence: The sequence is delimited by its start and end pins.

l The start, end or duration of the sequence can be modified by clicking and dragging the pins
to change them individually.
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l The entire sequence can be moved without changing the duration by clicking and dragging it
on the blue line.

A tooltip with a yellow background indicates
the current position in min: sec: on the Time-
line.

NB: The keyframes and guides do not follow the movement. Subsequently, the
numeric Time and Duration fields are updated.

The top of the time scale indicates the events that relate to an animated element.
The bottom of the time scale shows the events relating to one of the values for the animated ele-

ment in question.
Selecting keys of an animated element.

l Right clicking above the slide bar: displays the keys of an animated element, and selects
one of the elements.

Consequences:
n All animated keys corresponding to the element in question display on the slide bar.

n The inspector corresponding to the element becomes the current inspector, enabling
the user to edit its parameters rapidly.

NB: The user can also access the animated element by clicking on the triangle
located in the upper right-hand section of the window (above the slide bar).

Selecting keys of the current animated element.
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l Right clicking below the slide bar: Displays the animated settings for the current element.
The sub-keys matching the setting appear below the slide bar.

Result:
All sub-keys corresponding to the parameter for the element in question appear on the slide
bar.

NB: The user can also access the animated parameter by clicking on the triangle
located in the lower right-hand section of the window (below the slide bar).

NB: In order to select the parameter for an animated element, you must first
select the element and then select the parameter.

Recorder

l This enables the user to navigate in time through the scene, and to play or stop playback of
the sequence. The cursor moves as a result.

l Description of buttons from left to right:
n Go to start of sequence
n Go to previous image
n Play or stop sequence
n Go to next image
n Go to end of sequence

n Record animations: starts or stops the recording.

NB: Sequence playback can be started or stopped by pressing the space
bar.

Sequence Duration Control
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Current time of the scene: indicates the cursor's current position in
the time scale. Expressed in: minutes: seconds: image number. Entering a value
updates the position of the cursor. Dragging the cursor updates the scene time
again.

Duration of the current sequence: indicates the duration of
the sequence between the start and end pins. Expressed in: minutes: seconds: image
number. Entering a value updates the position of the end pin. Dragging the pins
updates the sequence duration.

Current sequence image: displays the number of the current image. Enter-
ing a value positions the cursor on the time line.

FPS: (frames per second), rate at which images are played per second .
Entering a value updates the number of frames played.

Loop: Indicates that the sequence will be repeated . Type in a value to spec-
ify the number of loops. The loop will be applied only to the current parameter of
the current animated element.

Keyframes: appear as colored guides distributed throughout
the time scale.
A pin represents a particular animation event at an instant T. A camera, light, hel-

iodon or object element for which one of the position, rotation, scale, etc. param-
eters has been modified.
Animation is interpreted between two keys.

Guides: serve as visual markers for synchronizing animated parameters.

l Animations: Makes a sequence or edit of animated elements the current
one, whereupon the appropriate inspector displays.

l Shortcut: Right click above the time scale.
l Modification indicator: Shows the type of animation attached to the current

element (position, rotation, lighting power, atmosphere, etc.). Updates depend-
ing on which item is selected in the Animations pop-up.
Shortcut: Right click below the time scale.

Keyframes and Guides

Keyframes

A keyframe indicates a particular event at an instant T in the scene. Keyframes are linked to the following animated
elements: cameras, lights, heliodons, objects and animated textures.
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Current animated elements at an instant T: Cameras, lights, heliodons, objects and animated tex-
tures.

Animated setting for current element:

Camera: position, rotation, focal, etc.
Light: position, state, type, power, color, etc.
Heliodon: date, time, etc.
Object: position, rotation, scale, etc.
Animated texture: plays the avi or mov sequence.

Animation is interpreted between two keys.

How Keys are Represented

General Information:

l Upper pin indicates a key relative to the current animated element.
l Lower pin indicates that an animated setting of the element is current.

Pin Description
An animated element with edit setting activated (in key). Keyframe not selected (gray).

An animated element with edit setting deactivated (no sub-key). Keyframe not selected (gray).

An animated element with edit setting(s) activated. Keyframe selected (red).

An animated element with edit setting deactivated (no sub-key). Keyframe selected (red).

An animated element. Synchronized editing of animated settings for the element in question. Represents
overlap of at least two keyframes.

More than one synchronized animated element. Move the yellow pin and the superimposed keys follow.
Keyframes selected (red).

n Moving the cursor over a synchronized key (yellow pin) displays the name of the current element,
the position in time and the parameters associated with the element.

More than one synchronized animated element. Move the yellow triangle and the superimposed keys follow.
Non-selected keyframes.

n Moving the cursor over a synchronized key (yellow pin) displays the name of the current element,
the position in time and the parameters associated with the element.

More than one animated elements are synchronized. The elements are not standard. Moving the yellow pin
with the arrow moves all superimposed keyframes. Non-selected keyframes.

n Moving cursor over synchronized keys: Displays the information concerning them
n Moving the cursor over a synchronized key (yellow pin) displays the name of the current element,

the position in time and the parameters associated with the element.

Page - 82



Artlantis Interface - Keyframes and Guides

Selecting keys of an animated element.

l Right clicking above the slide bar: Enables you to select an animated element.
l Consequences:

n All animated keys corresponding to the element in question are displayed on the slide bar.
n The inspector in question becomes the current inspector, enabling the user to edit its parameters rapidly.

NB: The user can also access the animated element by clicking on the triangle located in the upper
right-hand section of the window (above the slide bar).

Selecting keys of the current animated element.

l Right clicking below the slide bar: Displays the animated settings for the current element.The sub-keys match-
ing the setting appear below the slide bar.

l Consequences:
n All sub-keys corresponding to the parameter for the element in question appear on the slide bar.

NB: The user can also access the animated parameter by clicking on the triangle located in the lower
right-hand section of the window (below the slide bar).

NB: In order to select the parameter for an animated element, you must first select the element and
then select the parameter.

Creating keys

Three options:
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1. Upon creating a trajectory in 2D View: two keys are created in the Timeline window - one at the start and
one at the end of the sequence.

2. With record mode turned on in Timeline, right click on the path for the "Add Keyframe" pop-up menu (valid
only for one path).

3. In the Timeline window with record mode turned on, edit a parameter of the current element.

NB: When an element is no longer animated, turning on record mode will create two key images.
The one located at the start of the sequence assumes the parameter value before the modification.The sec-
ond one located in current time assumes the post-modification parameter value.

If the parameter of an element already has keyframes, the record mode creates a single keyframe. This key-
frame is located in the current time and has the post-modification parameter value.

NB: Turning on record mode in the Timeline window forces the 2D View to appear when editing key-
frames.

Cursor pop-up menu:
Right click on the cursor (blue or red bullet icon).

1. Add Keyframe:
n Position the cursor on the Timeline.

n Right click on the cursor to choose Add Keyframe.

Result: The keyframe is added.

2. Delete a Keyframe

n Right click on the keyframe and choose Delete Keyframe.
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Keyboard Shortcuts

1. Move a Keyframe:

n Click and drag the pin.

2. Duplicate a Keyframe:

n Alt+Click and drag the pin. (Both keyframes have the same value. Hence, they can freeze a parameter
at a given time.)

3. Moving a set of keyframes for an element (either the camera, lights, heliodon or objects):

n Shift+Click/Dragging the pin results in: all pins to the right of the click moving in a proportional time.

Guides:

These serve as visual Timeline tags (blue vertical line).
Enables the user to synchronize more than one animated element (e.g.: moving a camera must match the same instant
T as opening a door) or to synchronize animated settings tied to the same element.

l Creating a Guide: Double clicking in the Timeline (not on the slide bar) causes a vertical blue line to appear .
l Deleting a Guide: Double clicking on the vertical blue line makes it disappear.
l Moving a Guide: Drag and drop.

NB: Moving the cursor on the slide bar near a blue guide magnetizes the cursor. This makes it easier to syn-
chronize parameters among several animated elements.

1. Add Guide at the cursor
n Position the cursor on the Timeline.

l Right click on the cursor and choose the Add Guide item. Double clic in the Timeline near the cursor
will also add the guide for the cursor position.

The guide is created.
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2. Deleting a guide at the cursor

l Right click on the cursor and choose the Add Guide item. You can also double click the guide.
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The Perspectives Inspector

Manages viewpoints defined by a camera, a target and a focal length. Each viewpoint is considered to be an inde-
pendent document with its own parameters which can receive its own environment:

In this chapter you will learn about the following subjects:

The Perspectives List 88
Foreground Images 89
Background Images 90

Viewpoints List: for handling viewpoints displayed on the list.

1. Camera: settings, check elements to activate.
l Focal Length: by using the cursor or entering a value (Change the camera angle). The units depends on

the preferences settings.

l Depth of Field: click then, in the Preview window, click to define the clear point of the scene,
with the rest remaining blurred. The cursor adjusts the blur amount.

l Clipping Box: for defining clipping planes.
l Show: In 2D View
l Activate: Preview Representation

2. Lighting: To handle light schemes linked to the view, select them from the drop-down
menus.

l Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.
l Light Group: links one or more light groups to the view. Selecting "None" deactivates the light groups.
l Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.

3. Visible layers: check them in the drop-down menu.
4. Environment: handles the background and foreground of the scene.

l Defining a background: Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic
l Foreground Images
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l Site insertion tool automatically sets the camera with a background image.

Clicking opens the dialog.
5. Coordinates:

l Camera XYZ Position.

l Target XYZ Position. Clicking on locks them and clicking on unlocks them.
l It is possible to limit a camera's target to an object's movement: In Object mode, right click on and

object and select "Define As Target" in the drop-down menu. Then, in Perspectives mode select the
name of the object in question in the Target on menu.

l Camera Roll: Pivots camera laterally. Turn the circular cursor or enter a value in degrees in the related
field.

6. Post-production

l Applies effects to the current viewpoint: The effects combine with and between the parameters set in
the inspector.

7. Rendering Parameters

l Prepares the document for final rendering.

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via theWindow menu.

The Perspectives List

opens the viewpoint list. Each is displayed by name and preview thumbnail. To edit, double-click on the name.

adds a viewpoint

deletes it.

List drop-down menu

l Right-clicking on a view displays the pop-up menu:
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Duplicate: Uses the original to create a new superimposed viewpoint.
Delete: The viewpoint is removed from the list.
Add to Parallel Views List:
Add to Panorama list:
Add to VRObject List
Add to Animation list
Depending on option selected, adds current view from Perspectives to Parallel Views, Panoramas, VR
Objects or Animations.
Edit Heliodon: The palette inspector switches to Heliodon mode and the heliodon is selected.
Edit light: select a light, the inspector palette switches to Lights mode and the light is selected.

Foreground Images

Defining a Foreground

l A double click opens the search dialog for image files.

Loading Foreground Images

l By dragging and dropping into the inspector's Foreground image area.
l Using the Foreground image dialog: double click in the image zone.

NB: The foreground image must have an alpha channel (representing the opacity or transparency of
the image); for example, to view the scene through vegetation.
The file formats accepted are Photoshop, TGA, TIFF and PICT.
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Background Images

In the local Viewpoints menu:

or

Background
type

Description

3D Sky:
In the Viewpoints inspector, the current view is associated with a configurable 3D Sky:
day/night, type of clouds and cloud density.

This is assuming that the clouds have been associated with the heliodon.

and the heliodon in question has been associated to the current Viewpoint.

NB: If the viewpoint doesn't have an associated heliodon then the sky is white.

Graduated:
Three colors that mix linearly. By default, one top color, one middle color and one bottom
color, with one graduating horizontally towards the other.

2D Image:
Adjusts to the size of the Preview while maintaining its ratio (width x height). Use this option

to make an insertion in the site. To move the background image, Ctrl-click on the
thumbnail and drag the cursor.

Resetting the image position: double-click right on the thumbnail.

3D Image:
Creating a 3D environment from an image. To move the 3D background, Ctrl- click on the
thumbnail and drag the cursor.

Resetting the image position: double-click right on the thumbnail.

NB: Check the left-right continuity of the image being used.

3D Cubic:
Creates a 3D environment from a .mov file comprised of six surfaces of equal size. To move
the 3D background, Ctrl-click on the thumbnail and drag the cursor.

Resetting the image position: double-click right on the thumbnail.

NB: Check the left-right continuity of the image being used.

Loading a Background Image:

l By dragging and dropping into the inspector's area

l By using the background image dialog: double-click in the background image area

Page - 90



The Perspectives Inspector - The Perspectives List

Deleting a Background Image

l Click within the background image and then use the DEL key on your keyboard. A dialog will appear asking
you to confirm the deletion.

NB: the file formats supported are: Photoshop, TGA, TIFF, PICT, BMP and JPEG.
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The Parallel Views Inspector

Manages viewpoints defined by a viewpoint, a target and a display width. Each viewpoint is considered to be an inde-
pendent document with its own parameters which can receive its own environment:

In this chapter you will learn about the following subjects:

The Parallel Views List 94

Parallel Views List: for handling parallel views on the list shown.

1. Parallel views:
l Type of projection : Click on Elevation, Top, or Axonometry.
l Camera Roll: Pivots camera laterally. Turn the circular cursor or enter a value in degrees in the related

field (available only in Top View).
l Scene width: defines the width of the selected view (current unit).

NB: value modification depends of the ViewPoint Update Mode settings in Preferences.

l Clipping Box: for defining clipping planes.
l Show: in the 2D View
l Activate: Preview Representation.

2. Lighting: To handle light schemes linked to the view, select them from the drop-down
menus.

l Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.
Light Groups: Links one or more light groups to the view. Selecting "None" deactivates the light
groups.

l Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.
3. Visible layers: check them in the drop-down menu.
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4. Environment: handles the background and foreground of the scene.
l Defining a background: Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic
l Foreground Images.

5. Coordinates:
l Camera XYZ Position.
l Target XYZ Position.

6. Post-Production:
l Applies effects to the current viewpoint: The effects combine with and between the parameters set in

the inspector.
7. Parallel View Rendering Parameters:

l Prepares the document for final rendering.

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via theWindow menu.

The Parallel Views List

opens the viewpoint list. Each is displayed by name and preview thumbnail. To edit, double-click on the name.

l adds a viewpoint.

l deletes it.

List drop-down menu

l Right-clicking on a view displays the pop-up menu:
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l Duplicate: from the original, creates a new superimposed viewpoint.
l Delete: The viewpoint is removed from the list.
l Add to Perspectives list
l Add to Panoramas List
l Add to VR Object List
l Add to Animation list

Depending on the option selected, adds current Parallel view to Perspectives, Panoramas, VR Objects
or Animations.

l Edit Heliodon Activated With This Parallel View:
The inspector palette switches to Heliodons mode and the heliodon is selected.

l Edit Light Activated With This Parallel View:
Choose a light.The inspector palette switches to Lights mode and the light is selected.
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The Media Catalog

A media enables the project to be dressed by dragging and dropping the thumbnail view onto a scene medium (mate-
rial, object or background from the Preview window).

In this chapter you will learn about the following subjects:

Catalog Manager 98
Dressing the Scene with Media 99
Postcards 100
Using Postcards 101

Four types of Media: Shaders, Objects, Images and Postcards divided into two categories.

The Media Catalog window is divided into three areas: Favorites, Thumbnails and Preview.

1. Favorites:

n Lists the catalogs, edits catalogs.

2. Thumbnails:

n Displays Media thumbnails and adjusts their size.

3. Media Preview

n Drags and drops Media or Postcard elements to the scene.

NB: Additional samples of Media catalogs are available from Artlantis on DVD or free for download from
our site at www.artlantis.com
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Catalog Manager

Favorites area

Navigating Media Types

Used to go from one Media folder to another:

l Click on the catalog to be displayed in the favorites area. The Catalog structure is the one on the hard drive.

Adding a Catalog

Opens the dialog for locating folders.

l Selecting the Media folder to be added.

Updating Catalogs

Updates the content of a catalog folder whose content has been changed.

l Right click in the favorites area and select "Reload Favorites".

Removing a Catalog

l Deletes the selected catalog from the favorites area.

NB: Deleting a folder does not erase it from the hard drive. It is available only at the first level of the hier-
archy folders.
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Filtering Catalog Media Display

l Click on the local menu of the Display button.
l Select the desired option so that the media type you have selected will not be displayed.

Editing the Size of Catalog Thumbnails

l Change the cursor to display or reduce the size of the thumbnails.

Dressing the Scene with Media

Dragging and Dropping a Media from the Catalog to the Preview Window

In the Media view area, select the desired media and then drag and drop it into the scene over a material, object or
background (for only one image). The element that is ready to receive the Media is highlighted when the cursor
moves over it.
In this example, we are applying a shader to the wall:
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Result

Postcards
Collecting and Organizing Postcards. Collecting a Postcard is equivalent to taking a snapshot of the contents of the
current scene at any time, storing all parameters assigned to the materials: Colors, Shaders and textures. The idea is to
facilitate recovery of its settings and, if necessary, to be able to quickly send the information it contains to any other
user, or from one project to another.

Saving a Postcard

Saves the current view as a Postcard.
Tools Menu > Create a Postcard, a dialog box enables the user to name and specify the location where it is saved.

l Clicking on Save stores the Postcard. There is an unlimited number of saves.

NB: Postcards are saved to jpeg format either in a Postcards folder or another folder that you will have to
catalog.

NB: Although the Postcard is in jpeg format, editing it with an image touch-up program will cause it to lose
Shader and texture-specific information and makes it unusable in Artlantis.

From the Favorites area, navigate to a catalog containing Postcards and select the Postcard in the thumbnail area.

Using a Postcard

In the Catalog Preview area, simply drag and drop Postcard elements to an element displayed in the Preview win-
dow.

Sending a Postcard

To send Postcards, find the folder on your hard drive where the Postcards are saved.

l Find the Postcard on the hard drive and send it to another computer.To catalog the Postcard, use the Favorites
area in the Catalog window.

In Windows, Postcards are saved in the Postcards folder C:\Program Files\Artlantis Studio 3\Media\Postcards or Art-
lantis Render 3\Media\Postcards.

Deleting a Postcard

Locate the Postcard saved on the hard drive and delete it.
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Using Postcards
Select the Postcard. Drag and drop the attributes of a material (color, Shader, texture) to the receiving material in the
Preview window .

1. Starting scene

2. Drag and drop

3. Result

NB: Textures associated with a Shader are maintained and go with the assignment.

When a Postcard includes textures associated with a Shader, once it has been dragged and dropped to a material in the
scene, these textures will also be applied.
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The Shaders Inspector

Shaders

The following different types of shader are available: Basic Shader, Expert Shader,Realistic Glazing
Shader,Luminous Glazing Shader,Neon Light Shader,Realistic Water Shader,Texture, Diffuse Fresnel
Shader and Transparent Fresnel Shader

Procedural shaders (formerly Artlantis 4.5 Shaders)
Shaders: Procedural, Mirror, Transparent, Marble, Lines

NB: Shaders can be found in theMedia Catalog. Different types of Shaders may have different Shader inter-
face palettes.

NB: Editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via theWindow menu.

In this chapter you will learn about the following subjects:

Creating a Shader 103
Materials List 108
List Organization 108

Realistic Water Shader 110
The Neon Light Shader 111
The Basic Shader 112
Expert Shader 113
Transparent Fresnel Shader 114
Diffuse Fresnel Shader 115
Shaders: Procedural, Mirror, Transparent, Marble, Lines 116
Luminous Glazing Shader 117
Realistic Glazing Shader 118
Editing Textures 119
Materials List 119
Texture Mapping 120

Reaffect a Material 122
The Materials and Textures Pop-up Menus 122
Material 123
Texture 124

Creating a Shader
This is done using an existing Shader either:

l from the active Shaders inspector, menu: Tools > Create Shader From...

l or by right clicking on the name of a material and selecting the option Create Shader
From...

The edit dialog opens with the image of the current Shader. If the current Shader is a procedural, the dialog is empty.
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The dialog must be populated with images and values. Do this by dragging and dropping where appropriate or dou-
ble click on the thumbnail to open a dialog to choose an image.
Once stored, the new Shader will appear as a Standard Shader.
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1. Title:
l Enter the name of the Shader. This name will appear in the top left of the inspector.

2. Preview
This is the thumbnail that appears in the Shader Inspector and in the thumbnail field of the Catalog.
The thumbnail representing the Shader must be a 128 x 128 pixel jpeg file.
The width of the thumbnail gives the size of the image in cms to a scale of 1.

NB: If you do not provide a thumbnail, Artlantis will use the diffuse image resized to 128 x 128 pix-
els.

3. Diffuse:
The image must be present. This is the visible part of the Shader. Depending on the pattern, we rec-
ommend an image size of 512 x 512 or 1024 x 1024 pixels.

NB: If the image is not square, Artlantis will stretch it to make it square.

The diffuse width gives the the image in cm on a scale of 1.
Depending on the representation, this size may differ from the preview thumbnail. The diffuse image does
not necessarily represent the same image as the thumbnail.

NB: The diffuse image represents 4 times the size of the thumbnail image but its pattern is 3 x 3 the
size of the thumbnail in order to avoid a repeat effect.

The diffuse image is not visible in the Shaders inspector but displays in the Catalog Preview field.
4. Reflection

The image is optional. It is generally in gray scale but may be in color.
Its size in pixels must be the same as the diffuse image. Otherwise, Artlantis will stretch it depending on the
size of the diffuse image.
The purpose of the reflection image is to modify the value of the reflection cursor:
l In black pixels, the slider value is multiplied by 0.
l In white pixels, the slider value is multiplied by 1.
l In intermediary pixels, the slider value is multiplied by the intermediary value.

It is useful to limit the effects of reflection at certain parts of the diffuse image.

NB: The slider is limited to a minimum and maximum value. For example, entering a value of 0.35
will define a slider that will range from a minimum of 0 to a maximum of 0.35.

You can test the effects of each of the settings in real time in the Preview window.
5. Shininess

The image is optional and should be in gray scale.
Its size in pixels must be the same as the diffuse image. Otherwise, Artlantis will stretch it depending on the
size of the diffuse image.
The Shininess image is used to modify the slider value: Same as Reflection.

6. Bump:
If the Shader has no Bump image, the slider will be available in the Shaders inspector and Artlantis will use
the diffuse image to provide bumps. Hence, the bump image will always be available and will use less sys-
tem memory.

7. Normal:
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The image is optional. The colors use strict rules to define the bump simulation. Generally, it replaces Bump,
but Artlantis can support both.

Important: It is not simple to create a "Normal" image. If the Shader has no Normal image, the
slider will be disabled in the Shaders inspector.

8. Transparency:
The image is optional and should be in grayscale.
It is used to simulate holes and transparencies in the Shader.
l In black pixels, the Shader is opaque.
l In white pixels, the Shader is transparent.

9. Add Fresnel Effect:
If checked it adds to the created Shader the Fresnel Transition cursor

10. Save Shader as:

Opens the save dialog.

Create Shader and Shader Interface Match:
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Some Basic Shader settings are not available in Create Shader: Rotation, Mix Color, Transparency, Projection
Options, and Materials Identifiers have default values.

Materials List

Opens/closes the list of Materials.
They are displayed by name. To edit, double-click on a name.

Toolbar:

l Creates a new material based on the material selected.
n The material created appears at the end of the Materials List (before the Object Materials). The textures

linked to the duplicated material are also duplicated.

l Add a texture to the selected material. Select a TGA, JPEG, BMP, PICT, PNG, TIFF, EPIX, Pho-
toshop, MOV, AVI, or MPG file.

l Delete the selected material or the selected texture linked to a material. Activates when the material is not
associated with the geometry.
Shortcut: Hit the Back key.

l Enables the user to Reaffect a Material.

List Organization
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1. Material
Names of Materials in the scene are listed in alphabetical order and followed by the name of the Shaders.

2. Ground Material
This is the material applied to infinite ground (Scene Information). It appears at the top of the materials list.

3. Scene
Clicking on the Scene tab opens/closes the listed materials that are specific to the scene or internal com-
ponent.

4. Object Name:
Clicking on the Object tab opens/closes the list of Materials with Shaders and Textures linked to the object in
question.

5. Material Name
When the material is assigned, the name is written in black.

6. Shader Name
Follows the two full stops of the material name.

7. Texture Name
Follows the material or Shader name.
You can use drag and drop to re-arrange the order in which textures associated with a material are mapped.
Dragging and dropping one texture to another makes it dependent. This enables you to move them at the
same time.

8. Newly created materials not associated with geometry
The material name is shown below the listed materials.

9. Object Instance Name
The Object Instance is made up of several materials
The user can drag and drop a Shader onto a material in the list.
The Copy/Paste shortcuts can be used within this list.
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NB: Limitations - in an ATL reference file, any material that has been renamed or re-assigned will not be
recognized by the "Use Reference File..." command.
Here, we recommend that you go back to your modeler to distinguish the material names and then, if your mod-
eler allows it, update the atl file or use the "Use Reference File" function.

Realistic Water Shader

Materials List: displays the materials of the scene.

1. Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.

2. Saturation:
Use the slider to choose the color saturation level.

3. Transparency
4. Reflection, Shininess

Gives a reflective appearance to the material.
May be used in conjunction with the color from Diffuse, Transparency or both. Drag the slider to make the
material reflect its environment or enter a value in the related field. The reflection intensity is managed using
gray scale values or RGB values from 0 to 255. Click on the selector to choose a color.
Entering a Limit value defines the maximum distance of the reflection.

5. Fresnel Transition
6. Water surface:

Wave size: Drag the cursor to adjust the wave amplitude or enter a value in the related field. The wavelength
value can be from 0 to 500.
Flatness: Drag the wave amplitude cursor or enter a value in the related field.

7. Animation settings:
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Allows the user to automatically adjust the moving water effect which will only be visible in sequence
animation mode. If the box is unchecked, the movements are suspended.
Allows the user to animate the water movement speed. Values from 1 to 3.

8. Material ID Parameters:
Use the slider to choose the smoothness level for the material.

9. Material Characteristics:
The material is visible or invisible.
The material either casts shadows or it does not.
The material either receives shadows or it does not.

10. Shader/Textures Navigator:
For a material, this makes it possible to navigate between related Shader and Textures editors.

NB: effect only in Artlantis Studio in animation mode

The Neon Light Shader

Materials List: displays the materials of the scene.

1. Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.

2. Saturation:
Use the slider to choose the color saturation level.

3. Lighting Power:
Drag the slider to change power or enter a value (from 0.1 to 5000) in the related field. Click to choose a
color from the system color picker.

4. Transparency
5. Neon:

Drag the slider to adjust the neon power or enter a value in the related field. Click on the selector to choose a
color.

6. Shininess
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7. Material ID Parameters:
Use the slider to choose the smoothness level for the material.

8. Material Characteristics:
The material is visible or invisible.
The material either casts shadows or it does not.
The material either receives shadows or it does not.

9. Shader/Textures Navigator:
For a material, this makes it possible to navigate between related Shader and Textures editors.

The Basic Shader

Materials List: displays the materials of the scene.

1. Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.

2. Saturation:
Use the slider to choose the color saturation level.

3. Diffusion Color:
Another way to select a color is to click to choose a color from the system color picker.

4. Reflection, Shininess
Reflection: Drag the slider.When the diode is red, the material reflects its environment or enter a value in the
related field. Click on the diode to cancel the command.
Limit: Entering a Limit value defines the maximum distance of the reflection.

5. Transparency
6. Material ID Parameters:

Use the slider to choose the smoothness level for the material.
7. Material Characteristics:

The material is visible or invisible.
The material either casts shadows or it does not.
The material either receives shadows or it does not.
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8. Shader/Textures Navigator:
For a material, this makes it possible to navigate between related Shader and Textures editors.

Expert Shader

Materials List: displays the materials of the scene.

1. Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.

2. Saturation:
Use the slider to choose the color saturation level.

3. Diffusion Color:
Another way to select a color is to click to choose a color from the system color picker.

4. Reflection, Shininess
Gives a reflective appearance to the material.
The reflection intensity is managed using gray scale values or RGB values from 0 to 255. Click on the selec-
tor to choose a color.
Entering a Limit value defines the maximum distance of the reflection.

5. Transparency
6. Neon:

Drag the slider to adjust the neon power or enter a value in the related field. Click on the selector to choose a
color.

NB: Neon color does not emit light.

7. Material ID Parameters:
Use the slider to choose the smoothness level for the material.

8. Material Characteristics:
The material is visible or invisible.
The material either casts shadows or it does not.
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The material either receives shadows or it does not.
9. Shader/Textures Navigator:

For a material, this makes it possible to navigate between related Shader and Textures editors.

NB: Before editing a color, click on the button associated with the command.

Transparent Fresnel Shader

Materials List: displays the materials of the scene.

1. Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.

2. Saturation:
Use the slider to choose the color saturation level.

3. Reflection, Shininess
Gives a reflective appearance to the material.
May be used in conjunction with the color from Diffuse, Transparency or both. Drag the slider to make the
material reflect its environment or enter a value in the related field. The reflection intensity is managed using
gray scale values or RGB values from 0 to 255. Click on the selector to choose a color.
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Entering a Limit value defines the maximum distance of the reflection.
4. Fresnel Transition
5. Transparency
6. Material ID Parameters:

Use the slider to choose the smoothness level for the material.
7. Material Characteristics:

The material is visible or invisible.
The material either casts shadows or it does not.
The material either receives shadows or it does not.

8. Shader/Textures Navigator:
For a material, this makes it possible to navigate between related Shader and Textures editors.

Diffuse Fresnel Shader

Materials List: displays the materials of the scene.

1. Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.

2. Saturation:
Use the slider to choose the color saturation level.
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3. Diffusion Color:
Another way to select a color is to click to choose a color from the system color picker.

4. Reflection, Shininess
Gives a reflective appearance to the material.
The reflection intensity is managed using gray scale values or RGB values from 0 to 255. Click on the selec-
tor to choose a color.
Entering a Limit value defines the maximum distance of the reflection.

5. Fresnel Transition:
6. Material ID Parameters:

Use the slider to choose the smoothness level for the material
7. Material Characteristics:

The material is visible or invisible.
The material either casts shadows or it does not.
The material either receives shadows or it does not.

8. Shader/Textures Navigator:
For a material, this makes it possible to navigate between related Shader and Textures editors.

NB: Before editing a color, click on the button associated with the command.

Shaders: Procedural, Mirror, Transparent, Marble, Lines

Materials List: displays the materials of the scene.

1. Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.

2. Saturation:
Use the slider to choose the color saturation level.

3. Color Picker:
Shader defined by two, three or more colors (e.g. checkerboard).
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4. Shininess
Drag the slider to make the material reflect its environment or enter a value in the related field.

5. Roughness:
Moving the slider lets more or less light move on the material.

6. Color Table:
Defines the gradient mode between two colors. The mixture depends on the Shader's geometry. e.g. Check-
erboard, Lines, Stone, Marble, etc.
Click on the curve, keep the mouse button depressed and move to redraw the curve.
A horizontal line at the top or bottom of the table indicates that a single color is applied.
A diagonal straight line indicates a regular shading.

Flip: The button turns the Shader around its object.
Scale: Moving the slider adjusts the Shader proportionately.

7. Material ID Parameters:
Use the slider to choose the smoothness level for the material.

8. Material Characteristics:
The material is visible or invisible.
The material either casts shadows or it does not.
The material either receives shadows or it does not.

Luminous Glazing Shader

Materials List: displays the materials of the scene.

1. Color Selector:
Click to select a color or enter numerical values (1 to 255) in the RGB fields.

2. Saturation:
Use the slider to choose the color saturation level.

3. Lighting Power:
Drag the slider to increase power or enter a value (values from 0.1 to 5000) in the related field. Click to
choose a color from the system color picker.

4. Transparency
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5. Reflection, Shininess
6. Material ID Parameters:

Use the slider to choose the smoothness level for the material.
7. Material Characteristics:

The material is visible or invisible.
The material either casts shadows or it does not.
The material either receives shadows or it does not.

8. Shader/Textures Navigator:
For a material, this makes it possible to navigate between related Shader and Textures editors.

Realistic Glazing Shader

Materials List: displays the materials of the scene.

1. Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.

2. Saturation:
Use the slider to choose the color saturation level.

3. Transparency
4. Reflection, Shininess

Entering a Limit value defines the maximum distance of the reflection.
5. Fresnel Transition
6. Glazing Quality:

Allows a discontinuous reflection to be created when there is a break between several surfaces on the same
plane. This effect accentuates the realistic effect of reflection on a glazed surface.
Distortion size:
Determines the length of the undulation. Enter a value into the related field.
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X/Y:
To orientate the undulation mostly on the X- or Y- axis or both. The slider allows the proportion to be var-
ied. Enter a value into the related field.
Flatness:
Determines the amplitude of undulation. Enter a value in the related field.
Windowpane auto detection:
When checked, finds the limits of a contiguous shape to generate a glazed surface.

7. Material Characteristics:
Smoothness: Use the slider to choose the smoothness level for the material.

8. Shader/Textures Navigator:
The material is visible or invisible.
The material either projects shadows or it does not.
The material either receives shadows or it does not.

9. Shader/Textures Navigator:
For a material, this makes it possible to navigate between related Shader and Textures editors.

Editing Textures
A texture is an image or sequence that is imported onto a material. A material can receive one or more textures.

Materials List

Applying a texture is done either by:

l Using the Add Texture button in the Shaders inspector

l Right clicking on the name of the material and selecting the Add Texture...
option

l By dragging and dropping the texture thumbnail from the Catalog to a material in Preview mode or in the list.
l Dragging and dropping the texture from a location on the hard drive onto a material in Preview or in the list.

Deleting a texture is done either by:

l Clicking on the button to delete the current texture.
l Using the Delete background key.
l Right clicking the name of the texture and selecting Delete in the pop-up menu.
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Texture Mapping

1. Preview:
Displays the thumbnail of the selected Texture. The blue cross represents the anchoring point of the texture.
Clicking in the image repositions this point.

2. Rotation:
Use the circular cursor (Shift + Click, to step every 15°) to turn the texture on its axis or enter a value in the
related field.

3. Mix Color:
Check and click on the selector to choose a color.

4. Reflection
Move the slider to change the reflection or enter a value in the related field. When the diode is red, the texture
reflects its environment.
Double click on the red diode to cancel the effect.
Entering a Limit value defines the maximum distance of the reflection.

5. Shininess
Use the slider or enter a value into the related field.

6. Ambient:
Use the slider or enter a value into the related field.

7. Bump:
Use the slider or enter a value into the related field to simulate the effect of bumps or hollows on the surface
of the material using the levels of gray contained in the image.
Double click on the diode to cancel the effect.
Normal mapping

8. Transparency:
Apply a level of transparency to the texture or enter a value into the related field. Click on the diode to cancel
the effect.
Use Alpha Channel: Activates/deactivates the transparency of the alpha channel.
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Using a transparency color: Click on the selector to choose a transparency color.
9. Scale:

Button : The texture is automatically adjusted to cover the maximum surface of the material horizontally
and/or vertically.
The slider changes the texture scale from 50 to 200% of the current size. Or enter a value into the related
field.

10. Dimension, Spacing:
Width/Height:

Enter the size of the texture, clicking on retains the proportions. Click again to cancel the limitation.
Horizontal/Vertical Spacing:

Used for repeated textures. Defines the size of the spacing between each repetition.

Enter a spacing value as H and/or V. Clicking keeps the same proportions. Click again to cancel the lim-
itation.

Flip: horizontally or vertically inverts the texture with a mirror option between two repetitions.
Horizontal, Vertical repetition: duplicates the texture along the horizontal and/or vertical axis.
Horizontal Mirror, Vertical Mirror: Horizontally and/or vertically inverts each duplication.

11. Projection:
Adjusts the image to the surface on which it is placed. Automatically selects the adjustment best suited to the
project.

Planar: is applied to a plane.
Orthogonal: is applied to an element. If the element is composed of surface planes, the texture follows the
surface planes.
Horizontal: the Shader is required to be set horizontally.
Vertical: vertical projection on the element. The horizontal parts receive the image while the vertical or tilted
parts are stretched.
Spherical: adopts a spherical form that depends on the size of the texture. Hence, it may leave empty spaces.
YCylindric: the texture is projected around the axis of a vertical cylinder.
XCylindric: the texture is projected around the axis of a horizontal cylinder.
UV: maintains the texture coordinates on an object coming from software that manages UV maps.
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Planetary: vertical projection of the element while passing through the poles, without leaving spaces.
12. Shader/Textures Navigator:

For a material, this makes it possible to navigate between related Shader and Textures editors.

Reaffect a Material

Use the toolbar to reaffect a material

1. Click on the selection arrow ,

choose the type of selection in the drop-down menu , by triangles, planes, parallel planes, objects, material
or Magic Wand.

2. In the preview window, click on the items you want to reassign with the new material (click again on the selec-
tion button to cancel the current selection).

3. Click on the "Apply material" button .
4. Reaffect material dialog box pop-up:

5. Apply material to the current selection
There are two options:
"Apply a copy of the selected material" and "Apply the selected material".

l Apply a copy of the selected material:
Creates a copy of the selected material in the list. By default, the name remains the same as the original one.

l Apply the selected material:
Reaffect the selected material to the selected mesh. It is possible to change the selected material using the drop-
down menu.

NB: Elements making up an object cannot be selected.

NB: The File > Use Reference File command does not recognize reassigned or renamed materials.

The Materials and Textures Pop-up Menus
The pop-up menu depends on the name of the material or texture clicked.

Page - 122



The Shaders Inspector - The Materials and Textures Pop-up Menus

Material

l Right-clicking on a material name displays the following pop-up menu:

Create Shader From...

Opens the Create Shader dialog.

Apply to All Instances

Applies the modified material of an object to all identical objects in the scene.

Reset to Default

Applies the original material to the object.

Add Texture...

Open the dialog box and choose a TGA, JPEG, BMP, PNG, PICT, or Photoshop file.

Merge materials with Same Name

Materials with the same name will be replaced by the selected material.

Merge Material with the Same Shader

Materials with different names but having the same shader are grouped under the same name.

Merge Vertex

Merges superposed points of the polygons using this material.
(Avoids the problems of modeled object artifacts whose superposed points are not merged and allow the smoothing
of the polygons).

Visible

l If unchecked, the material becomes invisible.
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Cast Shadow

If checked, the material casts shadows on the other elements.

Receive Shadow

If checked, the material receives the shadows cast from other elements.

Delete All Unused Material IDs

Clears the materials that are not assigned to the geometry.

Delete

Deletes the selected material.

Split Material by Mesh

From an applied material the command creates into the list of materials as many as materials as meshes found.
Example:

NB: Does not delete a material from the original model.

NB: The File > Use Reference File command does not recognize reassigned or renamed materials.

Texture

l Right-clicking on a texture name displays the following pop-up menu:

Delete: erases the related texture.
Merge Texture Origin: upper left, upper right, lower left, lower right, center.
Determines the texture's anchor point. In Preview, the origin is represented by a black cross.
In the thumbnail, the anchor point is represented by a red and white cross.
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Used to edit geometry, materials, coordinates, dimensions and animation settings

Editing the geometry from the list
There are two ways of displaying the elements in the scene: by Hierarchy or by Layer

n By Hierarchy allows the user to select the elements making up the scene in view and edit them. See " The
Objects Inspector by Hierarchy" page 126

n By Layer allows the attached objects to be ordered by layer. See " The Objects Inspector by Layer" page 128
n Multiple selection.

In the list, the coordinates and dimensions of a multiple selection of objects may be edited at the same time.

NB: Editing the scene information such as the infinite ground, movement of the origin, redi-
mensioning of the model and the coordinates may be accessed via theWindow menu.

In this chapter you will learn about the following subjects:

The Objects Inspector by Hierarchy 126
Geometry 126
Object 127
Saving a scene: 127

The Objects Inspector by Layer 128
Layers 129
Geometry 130
Object 131

Editing the Scene 131
Editing Objects 133
In the case of a Standard object: 133
Object Animation 134

Creating an Object from a Scene 134
Selecting Polygons 134
Creating the Object 135
Canceling a Selection 135

The Objects List 135
Billboards 137
Availability: 137

Light Objects 139
Standard Objects 140
Object Animation 140

Vegetation Objects 140
Animated Character Objects 142
Behavior 142
Shader: 143
Coordinates 143
Object Animation 143

Instanced Object 143
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The Objects Inspector by Hierarchy
The elements listed represent the geometry of the scene and objects.
The contents of the inspector differs according to which option is selected from a list:

1. Scene geometry
2. Object added to the scene

Geometry

The name of a geometry selected in the list displays its coordinates, dimensions and animation parameters. These
parameters may not be edited.

NB: The settings related to the geometry cannot be edited (name, coordinates, dimensions).

l Delete the geometry from the list: does not affect dependent objects
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Object

The object settings can be edited as they are independent of the scene geometry.

Geometry pop-up menu selected

When the geometry is selected in the list, right-clicking the layer name displays a popup menu with the following
options:

l Use/Do not use as target: to define (depending on the activation in the viewpoint inspector) whether a geometry
element or an object is suitable for being used as a target for the cameras

l Delete object from the list.

NB: Multiple selection is available with these commands.

The objects are available in theMedia catalog

Object geometry

1. Edit Object

2. Types of objects: Standard, Light, Vegetation, Animated person and Billboard.
3. Creating an Object

Saving a scene:

To export a scene as an object, see Saving an AOF Document
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The Objects Inspector by Layer
Geometry elements are always contained in layers.
The layers come either from the CAD software, or are created in Artlantis.
The Inspector dialog changes according to which option is selected from a list.
There are three selection options:

1. Layers
2. Geometry
3. Objects.

Selecting more than one layer enables their visible/invisible status to be changed depending on the viewpoint.
Selecting multiple objects enables them to be moved to another layer.
Clicking the name of an object in the list makes its insertion point flash in the Preview window.

Renaming a layer

The name of the layer selected in the list is highlighted, select it to rename it.

NB: In Artlantis, renaming a layer created in the CAD software breaks the link to this layer. In this case,
modifications made using the "Use a Reference File..." command will not be recognized.
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Layers

1. Layer data:
name, number of instances contained, number of triangles making up the geometry

2. Actions on layers

l Use by default:
When you click the "Use by default" button, the layer selected becomes the default layer for dragged objects
dropped into the scene or objects created from the scene stored there.

l Hide/Display in the current view: displays what is necessary for the active viewpoint. Advantage: improves the
display and rendering.

3. Layer type:
None, Objects, 3D Vegetation, Billboards, Animated objects, Light objects
When you drag and drop objects into the Preview window, they can be stored automatically in the layers.
This is done by telling these objects what their destination layer is beforehand.
When a project is opened, Artlantis always assigns a default layer, its name is displayed in bold. This layer
receives any object added into the scene until another layer is declared as the "Default layer".
However, you can automatically associate certain types of object with certain layers
None: by default, the component dragged and dropped into the scene is stored in the layer whose name is
shown in bold, except if this type of component has already been associated with a specificObjects, 3D
Vegetation, Billboards, Animated objects or Objects with light layer.
To define a specific layer which is to contain a certain type of component, a new layer must be created in the
list or an existing layer chosen, then in Layer type, select the type.
Any layer in the list can be chosen. In the list, the symbol concerned will be assigned to the layer icon.

Example: You create a new layer. Then in Layer type, you click on Objects. All components (objects)
dragged and dropped will be stored automatically in this layer.

4. Actions on the view containing the visible layer:
Edit: depending on the layer selected, lists only the viewpoints where this layer is visible. In the popup menu,
select the name of the view. The Inspector changes to Viewpoint inspector and the selected view is dis-
played.
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Activate: depending on the layer selected, lists only the viewpoints where this layer is visible. In the popup
menu, selecting the name of the view activates it without changing Inspector.

5. Scene information: Displays the edit dialog for the scene

Geometry

Right-clicking geometry contained in the layer displays a popup menu with the following options:

l Use/Do not use as target: defines (depending on the activation in the viewpoint inspector) whether a geometry
element or an object is suitable for being used as a target for the cameras or lights.

l Delete: deletes the selected geometry contained in the layer.

l Move to: moves the geometry to another layer.

NB: The settings related to the geometry cannot be edited (name, coordinates, dimensions).

Object by Layer toolbar

Create a layer

1. Create a layer in the layer list. A new layer is added, click on the name of the layer to rename it.

2. To delete a selected layer, click
When the layer contains geometry, a warning dialog offers to transfer the elements in this layer to another via a
popup menu or to delete all the elements it contains.

NB: renaming or deleting layers which have been created by the CAD software breaks the link with
it when the "Use a reference file..." command is used.

Creating an object

Selected layer popup menu

When a layer is selected in the list, right-clicking the layer name displays a popup menu which lets you:

l Default: define this layer as default
l Hide in the current view: makes the layer invisible for the current view.
l Edit the view containing the layer: the inspector view changes to the Viewpoint Inspector.
l Activate the view which has this layer visible: the view becomes active without changing the inspector.
l Default layer for: defines the default type for this layer: Objects, 3D Vegetation, Billboards, Animated objects

and Light objects.
l Delete: deletes the selected layer, then displays the following dialog to move its content.
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l Delete all empty layers: deletes all layers which do not contain geometry.

NB: multiple selection is available with these commands.

Object

l Types of objects: Standard, Light, Vegetation, Animated person and Billboard.
The objects are available in theMedia catalog

Editing the Scene
Data related to the whole scene is displayed using a command from theWindow menu or from the Object inspector in
display mode by Layers.
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1. Scene Information:

l File location:
l Number of triangles making up the scene,
l Number of triangles making up the objects,
l Types and numbers of viewpoints,
l Structure of Light, Heliodon and Material Groups.

2. Infinite Ground:

l Checking/unchecking activates and deactivates the ground. The ground receives shadows,
Shaders and objects.

l Click on the Altitude cursor. Then, in the Preview window, click on the scene element
that will define the height of the ground, or enter a value into the related field.

l Edit Shader selects the Ground Shader and activates Shader edit mode.

3. Transfer the origin of the anchor point:

l Select the location of the new origin of the Scene.

Determine the object entry point (blue
ball)

Moves the scene origin.

Center X, Y and below 

Center X, Y and above.

Center X, Y 

Camera target.
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NB: For an .aof the default anchor point can be changed in the 2D view.

4. Scene Size:
Resizes: geometry, objects, cameras, lights, etc. No impact on the size of Shaders and textures.
Editing dimensions; if Keep proportions is checked, X, Y and Z remain homothetic.

5. Coordinates:

l Model XYZ Position. Enter values in the related fields to move the scene origin.

l Clicking on locks them and clicking on unlocks them.
l Rotation: Pivots the scene along the x, y and z axes.

Shift+click and dragging the cursor restricts the movement to 15° steps.

Editing Objects
Select an object from either:

l List of Objects
l The Preview Window
l The 2D View window

The inspector palette displays the information.

In the case of a Standard object:

1. Preview Thumbnail.
2. Edit Shaders...

l Choose the material to edit from the list, the Objects inspector switches to Shaders mode.
3. X, Y, Z Coordinates

l Position: Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines
the position.
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NB: For an .aof the default anchor point can be changed in the 2D view.

l Rotation: Pivots the object along the x, y and z axes.
Shift+click and dragging the cursor restricts the movement to 15° steps.

l Clicking on locks them and clicking on unlocks them.
4. Dimensions: changes the length, width and height settings.

l Click on the checkbox to maintain the proportions. Clicking again removes the restriction.
5. Animation Parameters:

Object Position: 3 options
Normal: The object always moves parallel to its starting position. (e.g. a vector that always retains its orien-
tation regardless of the object's path).
Orientation on path: The object moves in x, y, z in the direction of the path (e.g. an aircraft performing a
loop).
Orientation on path, XY only : The object moves in x, y, z in the direction of the path but always remains par-
allel to ground level x,y (e.g. a helicopter taking off).

NB: Using the timeline, in a single sequence, the object can change behavior several times.

Object Animation

See "The Timeline Window" page 77
See "Animatable Object Parameters" page 201

Creating an Object from a Scene
From the geometry selected in the Preview window.

Selecting Polygons

Use the toolbar in the object list

1. Activate .

2. Choose the type of selection in the drop-down menu, by triangles, planes, parallel planes, objects, mate-
rials or Object Wizard.

3. In Preview, click on the elements that will make up the object.

NB: an object cannot be created from elements already used for another object.

4. Activate .

NB: for an .aof the default anchor point can be changed in the 2D view.
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Creating the Object

The object remains linked to the project but is saved either in the atl document, or in an independent aof file. In this
case, the aof file can be used in other projects.

1. Name the object
2. Create an internal object, or Create an external object (.aof). In this case select the location where it is to be

saved.
3. Destination layer: choose the layer for the new object.

NB: the geometry used to make up the object no longer exists since it has been converted to an
object.

NB: the use of the "Use a Reference File..." command maintains control of the layers except in the
following cases when:
in Artlantis:
- the geometry from the CAD or modeler software contained in a layer has been moved to another layer.
- the names of the layers or the geometry contained in the layers have been renamed.
in the CAD or modeler software:
- the layers have been renamed or deleted.

Canceling a Selection

l Click on again.

NB: geometry selection does not work on Artlantis objects.

The Objects List

Opens the list of object groups.
The geometry is displayed either by hierarchy or layer.

n By Hierarchy lists the elements of the scene together with the associated objects.

n By Layer lists the geometry of the scene by layer together with the associated objects.
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l deletes the selected object (and its dependencies). Double-clicking on the object name edits the name.
Changing the dependence of an object in the hierarchy is done by dragging and dropping.

l The objects can be placed in a hierarchy so the group of objects can be translated by moving the parent object

NB: The Delete, Undo/Redo commands are available on the object list.

Pop-up menu for objects:

l Right-click on the name.

l Define as target: forces a camera to use the object as a target.
In the list, the object will have a red target in front of it.
In the Coordinate Viewpoint inspector, select the target object from the drop-down menu. Select target.

l Apply Gravity:
The anchor point of the object will drop to the surface beneath it.

Coordinates of the Perspective View Inspector:

l The selected object has been created from the contextual menu as explained above.
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Multiple selection

l In the list, the coordinates and dimensions of a multiple selection of objects may be edited at the same time.

Billboards
Billboards are composed of a surface plane and an image.

Availability:

Available in the Catalog Manager, "2D Billboards" folder.

Two types of Billboards

l Vertical, with relation to the ground (People and Vegetation).
l Flat, which lies flat on the receiving surface (Signs and Pictograms).
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1. Preview Thumbnail.
2. Horizontal and/or vertical symmetry.
3. Size of the element:

l Using the slider or by entering a value in the field (to go beyond the limits of the slider, type in a value.
The values of the slider will be updated accordingly).

4. Color:
Use the menu to change the color.

5. Transparency:
Used to render a Billboard with greater or lesser transparency depending on the desired level of trans-
parency: values from 0 to 100. 0 means opaque.

6. Display: Display Parameters in Preview
l Brightness: for changing brightness values from -0.25 to 0.25.
l Contrast: for changing contrast values from 0.5 to 1.5.

7. Coordinates:
Position:
l Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines the posi-

tion.

l Clicking on locks the coordinates and clicking on unlocks them.
l X, Y, Z Rotation: Pivots the object.

Shift+click and dragging the cursor restricts the movement to 15° step.

l Check to restrict the billboard to always face the camera.
8. Animation Settings1

1
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Light Objects

1. Preview Thumbnail.
2. Edit Shaders...

l Choose the material to edit from the list, the Objects inspector switches to Shaders mode.

3. Light Objects...

l Choose the light to edit from the list, the Objects inspector switches to Lights mode.

4. X, Y, Z Coordinates

l Position: Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines the posi-
tion.

l Clicking on locks them and clicking on unlocks them.
l Rotation: Pivots the object along the x, y and z axes.

Shift+click and dragging the cursor restricts the movement to 15° step.

5. Dimensions: for editing the parameters: length, width and height.

l Click on the checkbox to maintain the proportions. Clicking again removes the restriction.

6. Animation settings

NB: Using the timeline, in a single sequence, the object can change behavior several times.

NB: A light object's light cannot be deleted from the Lights inspector list. This must be done from the
Objects list.

See "The Timeline Window" page 77
See "Editing Paths" page 60
See "Animatable Light Parameters" page 201
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Standard Objects

1. Preview Thumbnail.
2. Edit Shaders...

l Choose the material to edit from the list, the Objects inspector switches to Shaders mode.

3. X, Y, Z Coordinates

l Position: Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines the posi-
tion.

l Clicking on locks them and clicking on unlocks them.
l Rotation: Pivots the object along the x, y and z axes.

Shift+click and dragging the cursor restricts the movement to 15° step.

4. Dimensions: for editing the parameters: length, width and height.

l Click on the checkbox to maintain the proportions. Clicking again removes the restriction.

5. Animation settings

NB: using the Timeline, in a single sequence, the object can change behavior several times.

Object Animation

See "The Timeline Window" page 77
See "Editing Paths" page 66
See "Animatable Object Parameters" page 201

Vegetation Objects
Available in the media manager "Free VB Visual Plants Samples" Vol. 1 and 2.
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1. Preview Thumbnail.
2. Height:

l Using the slider or by entering a value in the field.

3. Transparency:
Used to render a vegetation object with greater or lesser transparency depending on the desired level of trans-
parency: values from 0 to 100. 0 means opaque.

NB: When the slider is at the end, typing a higher numerical value allows the sizes to go beyond the
end. The slider values will be updated accordingly.

4. Representation date:

l Choose: active heliodon date or calendar date.

n Heliodon date: use the date of the active heliodon
n Calendar: use the selected date.

5. X, Y, Z Coordinates

l Position: Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines the posi-
tion.

l Clicking on locks them and clicking on unlocks them.
l Rotation: Pivots the object along the x, y and z axes.

Shift+click and dragging the cursor restricts the movement to 15° step.

6. Animation settings

NB: Using the timeline, in a single sequence, the object can change behavior several times.
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See "The Timeline Window" page 77
See "Working with Object Animations in 2D View" page 66
See "Animatable Object Parameters" page 201

Animated Character Objects

l Available in theMedia Catalog: Exterior, Furniture, Transport, etc.

1. Preview Thumbnail.
2. Rotation:

l Pivot the object on itself or enter a numerical value.
Shift +click dragged using the cursor limits the movement to a step of 15°.

3. Height:

l Using the slider or by entering a value in the field.

NB: When the slider is at the end, typing a higher numerical value allows the sizes to go beyond the end. The
slider values will be updated accordingly.

4. Color:

l Use the menu to choose the clothing color.

Behavior

5. Behavior: Use the menu to choose the character's attitude: standing, sitting, running, etc.
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The Objects Inspector - Instanced Object

Shader:

6. Shader

l Select the material to be edited from the list.

7. Reflection, Shininess, Bump:

l Reflection: drag the slider. When the diode is red, the texture reflects its environment. Double click on the red
diode to cancel the effect.

l Shininess: drag the slider to make the material become bright or enter a value in the related field.
l Bump: drag the slider to apply bump to materials or enter a value in the related field. Click on the red diode to

cancel the effect.

8. Mix Color:

l Check and click on the selector to choose a color.

Coordinates

9. X, Y, Z Coordinates

l Position: Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines the posi-
tion.

l Clicking on locks them and clicking on unlocks them.

Object Animation

See "The Timeline Window" page 77
See "Editing Paths" page 66
See "Animatable Object Parameters" page 201

Instanced Object
Principle: two objects: one table, one vase. The vase is placed on the table. If the table is moved, the vase follows the
movement

Instancing an Object

Using drag and drop:

l In Preview to another object
l In the list to the name of an object.
l In the list, the instanced object is shown off-center to the right under the reference object.

Delete a Dependency

l Drag and drop the dependant object to the "Model" name at the top of the list.
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NB: The level of instances is unlimited.
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The Heliodons Inspector

Manages the calculations for sunshine according to the position of the sun, determined by the place, time and type of
sunshine. One heliodon may be associated with one or more viewpoints.

In this chapter you will learn about the following subjects:

City Editor 147
The Heliodons List 147
Advanced Heliodon Parameters 148

Heliodons List: for handling heliodons on the list shown.

Sunlight:

1. Projection of the Sun's rays: Location, Manual or 45°.

l Location: Select a city from the local menu.

2. City Editor: edits the list of cities
3. Set date and time:

l either by clicking the arrows, editing the date dd/mm/yyyy and time hh:ss, or by moving the associated sliders.

4. Sunlight Power:

l Move the slider or type in a percentage value in the field. Clicking on the red diode resets the power to its initial
value.

5. Color Filter:

l Click on the color box to modify the color of the light coming from the sky. All elements in the scene receiving
projected light will be tinted with this color.

NB: Does not tint the sky.
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6. Shadows:

l The heliodon can cast shadows.The slider enables you to vary the shadows from hard to soft.

Light from the sky:

7. Power of light from the sky:

l Move the slider or type in a percentage value in the field. Clicking on the red diode resets the power to its initial
value.

8. Color Filter:

l Click on the color box to modify the color of the light coming from the sky.

NB: Tints the sky and the elements in the scene.

Clouds:

9. Four types of cloud Cirrus, Stratus, Cumulus and Cirrocumulus.

l Move the slider or type a value into the numeric field to vary the size of the clouds.

10. Cloud distribution:

l Click on to vary the distribution of the clouds or enter a value in the numeric field.

11. Clouds mask sun:

l If the box is checked, the sun remains behind the clouds. The sun rays will not be projected.

12. Click to open the Advanced Parameters dialog: pollution, halos, fog.

NB: Clouds are visible in the current view if the 3D Sky option is set in the Viewpoints inspector.

City Editor
Heliodon List
Advanced Heliodon Parameters

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via theWindow menu.

Heliodon Animation

See "The Timeline Window" page 77
See "Animatable Heliodon Parameters" page 200
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City Editor

World Map

l The chosen city is circled in red. Clicking on the map points to the closest city.

n Add creates a "New City":
n Double click on "New City" to rename it. Adjust the longitude and latitude parameters.

NB: Alt+click to edit the longitude and latitude of the current city.
The mouse wheel provides dynamic zoom capability.

l Delete deletes a city

City

l Lists all cities. Clicking on a name selects this city and the position is instantaneously effective on the world
map.

Longitude and latitude

l Geographic position of the current city.

GMT

l Time difference (Greenwich Mean Time).

+ 1 in summer

The Heliodons List

opens the heliodons list. Double-click on the desired name to change it.
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adds a heliodon, deletes the selected heliodon.
The heliodons are classified alphabetically, clicking on "Name" at the top of the list modifies the alphabetical order of
the classification.

l Right clicking on a heliodon displays the contextual menu:

Delete: The heliodon is removed from the list.
Activate for the Current View: Activates the heliodon for the current view (Name in bold).
Deactivate for Current View: Deactivates the heliodon for the current view.
Edit View Using This Heliodon: to choose a viewpoint, the inspector switches to Perspectives or Parallel
views, Panoramas, VR Objects or Animations mode.
Activate View Using This Heliodon: displays the chosen viewpoint in the preview window (the inspector
remains in Heliodon mode).

The Cut/Copy/Paste shortcuts are effective for the list.

Advanced Heliodon Parameters

Sky:

1. Pollution factor:
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The Heliodons Inspector - Advanced Heliodon Parameters

l Move the slider or type in a percentage value in the field.

2. Merge Sky Color With:

l Check the box to activate/deactivate the effect. Click the colored box to choose a color. The color is mixed with
the calculated sky color.

3. Luminous halo:

l Check the box to activate/deactivate the effect.
l Choose effect: Click on one of the four thumbnails.

4. Halo Power:

l Move the Power slider or type in a value between 0 and 100%.

Fog: set fog parameters

l Check the box to activate/deactivate the effect.

5. Starting distance: click then, in the Preview window, click on the point from which the fog will be able to
be perceived, or enter a numeric value in the field.

6. Visibility distance: visibility distance begins at the starting distance. It provides the fog with a volumetric effect.
7. Altitude: Altitude takes effect from bottom to top. It depends upon the starting distance and the visibility dis-

tance.
8. Color: for assigning a color to the fog.

Animation settings:
used to animate the movement of the wind along with its direction.

9. Wind

l Check the box to activate/deactivate the effect.
l Movement speed values go from 0 to 100.
l The direction is specified using the circular slider, direction being relative to project North (see 2D view).

NB: Effective only in Artlantis Studio in animation mode
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The Lights Inspector

Edit lighting schemes based on viewpoints. Interactive settings and immediate results in the Preview window. Using
the appropriate and correctly adjusted light model enhances the work carried out on the materials. Light groups may
be attached to one or more viewpoints. The lights are characterized by an illumination limit and a maximum illu-
mination area.

In this chapter you will learn about the following subjects:

Lights List 152

Lights List: for handling lights on the list shown.

Lighting

1. Select projection type
determines the lighting projection (fall-off) from 9 predefined types

2. On/Off
3. Color:

Double click to modify the source color.
4. Source power

Values from 1 to 1,000,000. Move the slider to change the power or enter a value.
5. Attenuation Distance

Calculates the attenuation distance for the lighting power.
Between the attenuation distance and source, the lighting power remains constant and at maximum.
The distance beyond distance A corresponds to the gradual diminishing of lighting power at 1/d 2;. When
the attenuation value equals 0, the light diminishes at 1/ d 2; beginning at the light source.
Enter the distance in the numerical field (current unit).

NB: In this area, the illumination principle is based on reality. The closer an object is placed to the
light source, the more illuminated it appears.

6. Change the Lighting Angle:
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By sliding from 10 to 360° or by typing in a numerical value.
Example: A value of 360° provides an omnidirectional light.

7. Shadow projection
Activate/Deactivate shadow projection: Click on the box to check it.

8. Shadow type
Sharpness slider on the edge of the illuminated area. Values from 0 (diffuse area between the shadow area
and the illuminated area) to 100 (straight limit). Accepts a numerical value.

9. Luminous halo:
Activate/Deactivate: Click on the box to check it.

Choose effect: Click on one of the thumbnails:
Halo Power: Move the Power slider or type in a value between 10 and 200%.

10. X, Y, Z Coordinates: of the position of the light source and its target.

Clicking on locks them and clicking on unlocks them.
Activated target: choose between target on a fixed vertex or on an object defined as target.

NB: Editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via theWindow menu.

Animations:

See "Editing Paths" page 60

See "The Timeline Window" page 77

See " General Preview Display Shortcuts" page 215

See "Animatable Light Parameters" page 201

Lights List

opens the list of light groups.

l Double-click on the name of a group or a light to edit the name.
l Moving a light from a group to another group is done by dragging and dropping.

l adds a light group,
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The Lights Inspector - Lights List

l adds a light at the current camera position if a group is selected. Duplicate the light if a light is selected.

l deletes the selected light or group.

Light Group Pop-up Menu:

l Right clicking on the name of the group displays the contextual menu:

Paste: Pastes the clipboard contents
Delete: removes the selected elements.
Activate/Deactivate for Current View: the group takes part or otherwise in the lighting of the current view.
Edit View Using This Light Group: Choose the view point, the inspector switches to Perspectives or Par-
allel views, Panoramas, VR Objects or Animations.

Light Pop-up Menu:

l Right clicking on the name of the light displays the contextual menu:

Activate/Turn off: the light
Duplicate: Creates a light identical to the current light.
Cut: The cut light is stored in the clipboard.
Copy: The copied light is stored in the clipboard.
Delete: Removes the selected lights.
Edit View Using This Light: Choose a viewpoint from the list. The chosen viewpoint is displayed in the pre-
view window. The inspector switches to Perspectives, Parallel views, Panoramas, VR Objects or
Animations mode accordingly.
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Selection and multiple editing of lights:

The Cut/Copy/Paste shortcuts are effective for the list.
To instantaneously assign a setting to several sources.
Select the sources by using:
Ctrl click for a discrete selection. Shift click for a continuous selection.
The multiple selection is represented by hatching icons as well as dots in the numerical fields.
When you change a parameter, it will be changed for all selected lights.
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The Site Insertion Tool

In the Perspectives inspector , Insertion enables the user to position a camera precisely vis-a-vis a model or photo.
Position a background image before using this command.

In this chapter you will learn about the following subjects:

Step 1 - Setting the Axis Markers in the 2D View 155
Step 2 - Setting the Axis Markers in the Preview Window 156
Step 3 - Running the Insertion Calculation 157

Opening the Insertion Command

l Click on
l The insertion dialog enables you to define the focal distance of the image, gives you the option of adjusting the

axes, and allows you to choose the reference axis, display the model and run/stop the calculation.

NB: When opening the dialog, the model from the preview window is hidden. The background image
remains, with a marker for the axes, which appear in red, green and blue.

Insertion is carried out in two steps: placement of a trihedron into the 2D view and into the Preview window.

Step 1 - Setting the Axis Markers in the 2D View
Setting the orthonormal marker on the geometry is performed in two steps in top view and in another view. If needed,
in the top view, pivoting one of the red or green axes will rotate the marker on the origin.
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The changes made to the axes in 2D View are not updated in the Preview window. This is why we must also set the
marker in this window. See step 2.

Step 2 - Setting the Axis Markers in the Preview Window

Place the origin of the axis marker on the photo, then pivot the red, green and blue axes one by one.

NB: Make sure that the positions of the axes in 2D View and Preview do not conflict.

In the insertion dialog: Depending on the placement of the axes in preview, choose one of the following two view-
ing options:

The Y axis moves away from or towards the camera.

Determine the axis that will serve as a reference for sizing the 3D model in relation to the back-

ground image. Then, in the Preview window, adjust the size to the model by moving the yellow handle . Do
the same in 2D View.
In the Preview Window: The magnifying glass helps you place the axis marker precisely on the background image.
To activate the magnifying glass, turn the mouse wheel. Each incrementation increases the zoom from x2 up to a max-
imum of x8.
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The Site Insertion Tool - Step 3 - Running the Insertion Calculation

Step 3 - Running the Insertion Calculation

In the insertion dialog, check . The model displays in Preview, and then launch . At any
time, the axes can be modified in real time in the Preview and 2D View windows. If the setting appears incorrect,

modify the value of the camera focus , adjust the slider or, if you know the value, re-enter
it directly into the appropriate field.

stops the calculation.

NB: In order to avoid any inadvertent modification, when the insertion dialog is closed, the view locks auto-
matically.

To unlock it in the Perspectives inspector, open Coordinates, then click on the padlock .

To start again from the beginning, use the Cancel button.
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Post-Process Effect Filters

Enables the user to apply effect filters to the current view:

l The effects are added to the view, as well as to the parameters set in the viewpoint inspectors.
l The Post-Process effects are "viewpoint dependent". Their settings do not affect other viewpoints.
l The check boxes activate/deactivate the effects.

In this chapter you will learn about the following subjects:

Tone Settings 160
Examples: Post-Process Rendering 160

1. Image settings
Use the sliders or enter numeric values to set Contrast, Brightness and Saturation. Values from -100 to
100.
Clicking on the red diode cancels the effect.
TheMix Color box enables you to select a tint mix from the color picker, which will cover the entire image.

2. Exposure
Exposure: Determines the amount of light that enters the camera.
Size: Fluffs the effect to a greater or lesser extent.
Values from 0 to 100 for these two settings.

3. Grain:
Brightness: Gives the image a granular appearance.
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Size: Determines the size of the grains.
Values from 0 to 100 for these two settings.

4. Edge and Pastel
Provides a photorealistic rendering mixed with crayon, or a completely crayoned rendering.
Edge intensity: Marks more or less the weight of the lines that determine the geometry contours.
Transparency: More or less masks the geometry while retaining the intensity of the contour and the pastel
effect.
Pastel Effect: Provides a crayoned rendering effect.
Values from 0 to 100 for these three settings.
Validate or cancel these settings to close the dialog again.

5. Saved settings
Define as default/Default settings/Apply to all perspective viewpoints:
Respectively allow the user to revisit Artlantis initial settings, to define current settings as the default or prop-
agate these settings to all other perspectives.

NB: Post-process effects are immediately visible in the Preview window.

When rendering, Artlantis always calculates in photorealistic rendering and applies the filters when the calculation is
finished.

Examples: Post-Process Rendering

Tone Settings

Enables the user to apply tone settings filters to the current view:

l Light Tones: Move the cursor to the right to darken the lighter tones.
l Dark Tones: Move the cursor to the right to lighten the darker tones.

Examples: Post-Process Rendering
The effects can combine together to provide an extremely rich variety.
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Post-Process Effect Filters - Examples: Post-Process Rendering

Initial Photorealistic rendering

Desaturation Contrast brightness and saturation

Contrast brightness and saturation Edge and pastel

Edge and transparency Edge transparency and pastel
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Pastel Transparency and pastel

Exposure Grain

Grain exposure edge and transparency Edge with no transparency
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Rendering

In this chapter you will learn about the following subjects:

Perspective Rendering Parameters 163
Expert Mode Viewpoint Rendering Parameters in the "Photorealistic" Engine 164
Render 167
Rendering Animations 167
Panorama Rendering 168
Artlantis Batch Render 171
The Batch Rendering Window 173
The Partial Rendering Window 175
Panorama Rendering 176
Parallel View Rendering Settings 179
Panorama Rendering Parameters 180
VR Object Rendering Parameters 183
Animation Rendering Parameters 184

Perspective Rendering Parameters
Accessible by:

l Clicking on the icon available in the Perspectives inspector. The set values determine the rendering and
display in the Preview window.

1. Display of rendering options for the "realistic photo" engine in the current mode
Rendering size
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Print Resolution for Perspective View1

2. Anti-aliasing

Anti-aliasing: anti-aliasing Normal / High.

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity

The calculation times depend on the value chosen.
This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.
Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.

4. Application settings

Define as default / Default settings / Apply to all viewpoints for the selected inspector :
Respectively allow the user to define current settings as the default, to use the default settings or propagate these set-
tings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.

Expert Mode Viewpoint Rendering Parameters in the "Photorealistic" Engine

l Click on the icon available in the viewpoint and animation inspectors. The set values determine the ren-
dering and display in the Preview window.

NB: The display of options in expert mode is activated in the Preferences dialog.

1
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Rendering - Expert Mode Viewpoint Rendering Parameters in the "Photorealistic" Engine

1. Display of options in standard mode
Rendering size
Print Resolution for Perspective View1

2. Anti-aliasing

Anti-aliasing: Anti-aliasing Low/High

Tip: To save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity

The calculation times depend on the value chosen.
This menu allows you to set the precision parameters with predefined values. If you change the values with the slid-
ers or the text fields, the menu will be set to custom.
Precision: Normal/Average/High/Custom.

NB: These settings have a very strong influence on the rendering time.

1
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Tip: Calculate small-sized images or use the Batch Rendering command.

l Widened oversampling: Values from 96 to 8 pixels.
The radiosity is calculated over a small number of pixels, the others are extrapolated. This distance represents
the mean distance in pixels between two points where radiosity is calculated. The lower the distance, the
more the density of calculated pixels increases.

NB: These settings have a very strong influence on the rendering time.

l Reduced oversampling: Values from 0 to 48 pixels.
This is the radiosity from near surfaces (e.g. the corner between 2 walls). This requires special processing
enabling shadow quality to be refined. The value selected represents the processing range. If 0, no calculation
is carried out. The larger the value, the better will be the calculation of shadows with regard to radiosity.

NB: These settings have a strong influence on the rendering time.

Lighting: Interior/Exterior/Custom.
These settings affect the general ambient lighting for the scene. They are used to precisely control how the scene is
exhibited.
The predefined settings Interior/Exterior give default lighting settings depending on the space chosen.
The Custom setting is used when the user opens a file prior to version 3 of Artlantis or when the lighting values have
been changed in expert mode.

NB: These parameters do not affect the calculation times.

Lighting power:

l First rebound: values from 1 to 16.
Controls the radiosity power of the first rebound (affects all surfaces receiving direct light from a heliodon or
light sources).

l Next rebounds: values from 1 to 16.
Controls the radiosity power of all rebounds after the first. This affects surfaces receiving indirect light.
Increasing the number of rebounds gives more light, particularly for interior scenes.

l Attenuation: values from 0 to 1.
Controls absorption of light after one or more surface rebounds. A low value increases the contrast of the
scene thus allowing strong shadows to be cast in an interior scene lit by indirect lighting.

NB: this parameter has almost no effect on exterior scenes.

l Color transfer: values from 0 to 1.
Controls the transfer of colors between surfaces.
Reducing the value desaturates the colors.

4. Application settings

l Define as default/Default settings/Apply to all perspective viewpoints
Allow the user to define the current settings as the default settings, to use the default settings or propagate
these settings to all other views for the inspector concerned.
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Render

Inspector Menu > Render

Specify the name, destination of the file and format in the dialog box: JPEG*, BMP*, TGA, PICT, TIFF, Piranesi or
Photoshop**.

NB: * Formats that use the alpha channel. ** Photoshop PSD multi-layer format.

l Clicking on Options... opens the Rendering Parameters dialog.
l Render Now: Opens the rendering window, then displays the rendering progress and the estimated and

elapsed computation times. To stop the rendering click on the close box of the window.
l Render Later:

Postpones the rendering of the current viewpoint, the document is automatically saved. Rendering will be
done using Artlantis Batch Render.

NB: Batch rendering is managed later in the Inspector menu > Batch Rendering... It is processed by Art-
lantis Batch Render.

Rendering Animations

Inspector Menu > Render

Format:

l Specify the name, destination of the file and format in the dialog box: MOV, JPG or TGA

Compression Parameters:

l Choose a Codec and a compression quality.
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Quality:

l Choose a compression rate:

For low compression, move the slide to the left. For high compression, move it to the right.

l Clicking on Options... opens the Rendering Parameters dialog.
l Render opens the rendering window

Shows the progress and the estimated and elapsed time of calculation. Work on the project cannot continue at
the same time as the renderings.

l Postponed rendering saves the document.
Postpones the rendering of the current animation.

Stop Rendering in Progress.
Click on the "Close" box.

NB: Batch rendering is managed later in the Inspector menu > Batch Rendering... It is processed by Art-
lantis Batch Render.

Panorama Rendering

1- Rendering a Panorama:

Each rendered node is composed of six images saved in jpeg files. The file format of the panorama is html, to be
played on a web browser.
Select a destination folder.

The rendered panorama:
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Rendering - Panorama Rendering

Into the destination folder, a folder with the name of the panorama is created. Inside are two folders named assets and
player and one html file with the name of the panorama.

The asset folder contains all jpeg square images of the panorama a promenade.xml file and a special folder.

The player folder contains the files necessary to run the panorama animation with a web browser, among them the
Flash swf file.

A double click on the html file launches the current web browser, the panorama is displayed in a navigation window.
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Click and drag the cursor into the window, the camera turns on itself at 360°.

To move from a node to an other one:

They are two ways to switch from one node to another: One is using the thumbnails list and one is using the sensitive
triangles.
A- Using the thumbnail previews list:
Move the cursor into the lower part of the window a drawer displays the thumbnails of the panorama nodes.

Click on a thumbnail to switch to an other node.
B- Using the sensitive points displayed into the window
The sensitive points are the blue triangles followed by their names, a click on a triangle or its name to navigate to this
node.

To display a full screen the panorama click on the icon in the lower right corner of the Web page.

2- Navigation option:

Another way to navigate into a 3D base is to overlap to the 3D View on the associated plan level, then to navigate
from one node to an other one by a click on a triangle or its name, doing so it switches to the corresponding node and
hides the plan level.
We just need to associate these plan levels with the already rendered panorama.

To do so:

Activate the parallel inspector then select the Type of projection: Top. In case of multiple levels create as many Top
views as necessary.
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Very important: to keep the level hierarchy of the 3D base, the name of the points of views must be set on 2 digit
numbers (space before between or after the digits are not allowed) Example: 00, then 01, 02... where 00 rep-
resents the basic level.

In 2D View, display an elevation view (Front, Right, Left or back). Set the point of view by moving the camera and
the target. See " Working with Parallel Views in 2D View" page 34
The point of view will refer to the higher part of the plan shown into the navigator.
Render the levels and save them into the special folder located into the asset folder when we rendered the panorama
(as explained previously)See "1- Rendering a Panorama:" page 168.

When launching the panorama a new button will get displayed into the left corner of the window.
A click on the icon displays the plan level centred into the window. Another click on the icon hides the current plan
level.

When the plan level is displayed its name is showed at the top of the plan.
The sensitive nodes of the panorama are displayed on the plan. The current node is surrounded by a dynamic red cir-
cle. A click on a node will hide the plan and display the associated point of view in the navigation window.
To navigate from a plan level to an other use the arrows placed to the left or to the right of the plan.

Flash Player from Adobe company must be installed to perform the reading of the panorama.

http://www.adobe.com/support/flashplayer/downloads.html

Artlantis Batch Render
Artlantis Batch Render is an application independent of Artlantis. It launches the Artlantis batch rendering cal-
culation. It is located into the installed Artlantis folder.
When launched, the render later manager displays the waiting renderings.
If in Artlantis no Render later documents have been saved, then the list is empty.
If Render later documents have been saved the documents are listed.
The render later list manager can be used to change settings on documents to render, thus editing the rendering set-
tings without reopening the Batch Rendering window of Artlantis.
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Toolbars

l Deletes the selected view

l Mark the selected view as needed to be calculated, even if it has already been rendered.

l Launches the rendering. The Rendering windows is opened.
l Image type: to redefine the rendering image format: JPEG, BMP, TGA, PICT, PNG, TIFF, Photoshop,

Piranesi or HTML or movie formats.
l Indexed: names of renderings with the same name will be indexed numerically

or
l Replaced: the name of a render with the same name will replace the existing file.

l Destination: the destination of the rendering file can be redefined by clicking on the Folder button.

The Document List:

l Check the box opposite the name of the image in the list. This image will be rendered later.

n Document name: the name of the atl file
n View Name: the name of the viewpoint
n Kind: type of viewpoint; Perspective, Parallel, Panorama, Animation or VR object.

Diodes: color codes
Diode Status Comments

Gray Not rendered yet Waiting for processing by Artlantis Batch Render if the box is
checked.

Green Rendered

Orange Error during rendering Check the information at the bottom of the Batch Rendering window

Red Not rendered due to one or more
errors

Check the information at the bottom of the Batch Rendering window
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Rendering - The Batch Rendering Window

The window makes it possible to track the progress of the listed renderings. Each rendering displays a small progress
image (1). A report (2) provides details on:

l The location of the document and the image calculated on the disk.
l The size of each image and the time it took to render.
l Potential problems with the location of textures, Shaders, etc.

Quit

l The Quit button closes the application, even if a calculation is in progress. The interrupted calculation infor-
mation remains in the batch render document (BatchRendererDocument.xml). Relaunching Artlantis Batch
Render will restart where it was stopped.

Pause

l Stops the image calculation in progress.

Resume

l Resumes the currently paused image calculation.

The Batch Rendering Window
All batch renders are processed by the "Artlantis Batch Render" application.

Inspector Menu > Batch Rendering.

The Artlantis rendering manager displays the list of items that are to be processed.
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Toolbars

l Deletes the selected view

l Mark the selected view as needed to be calculated, even if it has already been rendered.

l of the current project to the list of views that need to be rendered.
l Image type: to redefine the rendering image format: JPEG, BMP, TGA, PICT, PNG, TIFF, Photoshop,

Piranesi, html or movie formats.
l Indexed: names of renderings with the same name will be indexed numerically

or
l Replaced: the name of a render with the same name will replace the existing file.

l Destination: the destination of the rendering file can be redefined by clicking on the Folder button.

Viewpoints List:

l Check the box opposite the name of the image in the list. This image will be rendered later.

n Document name: the name of the atl file
n View Name: the name of the viewpoint
n Kind of view: type of viewpoint; Perspective, Parallel, Panorama, Animation or VR object.

Diodes: color codes
Diode Status Comments

Gray Not rendered yet Waiting for processing by Artlantis Batch Render if the box is
checked.

Green Rendered

Orange Error during rendering Check the information at the bottom of the Batch Rendering window

Red Not rendered due to one or more
errors

Check the information at the bottom of the Batch Rendering window
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The Partial Rendering Window
Calculates part of the content of the Preview window.

Inspector Menu > Partial Render

1. Draw a rectangle in the Preview Window. The Render window showing the progress is displayed.

2. Defining the rectangle

3. Render window showing the progress of the calculation.
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Panorama Rendering

1- Rendering a Panorama:

Each rendered node is composed of six images saved in jpeg files. The file format of the panorama is html, to be
played on a web browser.
Select a destination folder.

The rendered panorama:

Into the destination folder, a folder with the name of the panorama is created. Inside are two folders named assets and
player and one html file with the name of the panorama.

The asset folder contains all jpeg square images of the panorama a promenade.xml file and a special folder.
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The player folder contains the files necessary to run the panorama animation with a web browser, among them the
Flash swf file.

A double click on the html file launches the current web browser, the panorama is displayed in a navigation window.

Click and drag the cursor into the window, the camera turns on itself at 360°.

To move from a node to an other one:

They are two ways to switch from one node to another: One is using the thumbnails list and one is using the sensitive
triangles.
A- Using the thumbnail previews list:
Move the cursor into the lower part of the window a drawer displays the thumbnails of the panorama nodes.

Click on a thumbnail to switch to an other node.
B- Using the sensitive points displayed into the window
The sensitive points are the blue triangles followed by their names, a click on a triangle or its name to navigate to this
node.
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To display a full screen the panorama click on the icon in the lower right corner of the Web page.

2- Navigation option:

Another way to navigate into a 3D base is to overlap to the 3D View on the associated plan level, then to navigate
from one node to an other one by a click on a triangle or its name, doing so it switches to the corresponding node and
hides the plan level.
We just need to associate these plan levels with the already rendered panorama.

To do so:

Activate the parallel inspector then select the Type of projection: Top. In case of multiple levels create as many Top
views as necessary.

Very important: to keep the level hierarchy of the 3D base, the name of the points of views must be set on 2 digit
numbers (space before between or after the digits are not allowed) Example: 00, then 01, 02... where 00 rep-
resents the basic level.

In 2D View, display an elevation view (Front, Right, Left or back). Set the point of view by moving the camera and
the target. See " Working with Parallel Views in 2D View" page 34
The point of view will refer to the higher part of the plan shown into the navigator.
Render the levels and save them into the special folder located into the asset folder when we rendered the panorama
(as explained previously)See "1- Rendering a Panorama:" page 176.

When launching the panorama a new button will get displayed into the left corner of the window.
A click on the icon displays the plan level centred into the window. Another click on the icon hides the current plan
level.

When the plan level is displayed its name is showed at the top of the plan.
The sensitive nodes of the panorama are displayed on the plan. The current node is surrounded by a dynamic red cir-
cle. A click on a node will hide the plan and display the associated point of view in the navigation window.
To navigate from a plan level to an other use the arrows placed to the left or to the right of the plan.
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Flash Player from Adobe company must be installed to perform the reading of the panorama.

http://www.adobe.com/support/flashplayer/downloads.html

Parallel View Rendering Settings
Accessible by:

l Clicking the icon available in the Parallel Views inspector. The set values determine the rendering and
display in the Preview window.

1. Display of rendering options for the "realistic photo" engine in the current mode
Same parameters as for rendering Perspectives, except for printing.
Rendering size
Print Resolution for Parallel View1

2. Anti-aliasing

Anti-aliasing: anti-aliasing Normal / High.

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity

The calculation times depend on the value chosen.
This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.
Precision : Normal / Average / High / Custom .

1
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Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.

4. Application settings

Define as default / Default settings / Apply to all viewpoints for the selected inspector :
Respectively allow the user to define current settings as the default, to use the default settings or propagate these set-
tings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.

Panorama Rendering Parameters
Accessible by:

l Clicking on the icon available in the Panorama inspector. The set values determine the rendering and dis-
play in the Preview window.
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1. Display of rendering options for the "realistic photo" engine in the current mode

Flash Player size: Defines the size of the Flash player.
Small 800 x 600, Normal 900 x 500 (iPad), Large 1280 x 720

l Select a size from the menu or
l Enter theWidth and Height in pixels of the Flash Player.

The size represents the default display in the rendering window.
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l Increase/decrease the values by two by clicking on the icons.

Rendering size
The size in pixel of the calculated images. The rendering is always in a square format.
Select a size from the drop down menu: 640 x 640, 1024 x 1024, 1600 x 1600 or 2048 x 2048.

Recommended size:

l 640 quick check or small Web format.
l 1024Web page usage and for iPad (1 or 2) and iPhone.
l 1600 local usage with Flash
l 2048 local usage with Flash or for iPad 2 in HD.

Choosing a higher value definition gives a better quality, especially when zooming in the navigator. But it will need a
longer rendering time.

NB: The nodes of the panorama are composed of six square images.

2. Anti-aliasing

Anti-aliasing: anti-aliasing Normal / High.

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity

The calculation times depend on the value chosen.
This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.
Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.

4. Application settings

Define as default / Default settings / Apply to all viewpoints for the selected inspector :
Respectively allow the user to define current settings as the default, to use the default settings or propagate these set-
tings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.
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VR Object Rendering Parameters
Accessible by:

l Clicking on the icon available in the VR Object inspector. The set values determine the rendering and dis-
play in the Preview window.

1. Display of rendering options for the "realistic photo" engine in the current mode

Rendering size
Number of images: Information on the number of images to be rendered to make up the VR objects depending on ver-
tical and horizontal step.

2. Anti-aliasing

Anti-aliasing: anti-aliasing Normal / High.

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity

The calculation times depend on the value chosen.
This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.
Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.
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4. Application settings

Define as default / Default settings / Apply to all viewpoints for the selected inspector :
Respectively allow the user to define current settings as the default, to use the default settings or propagate these set-
tings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.

Animation Rendering Parameters
Accessible by:

l Clicking on the icon available in the Animations inspector. The set values determine the rendering and
display in the Preview window.

1. Display of rendering options for the "realistic photo" engine in the current mode

Film size

l Select a size from the menu or enter the width and height in pixels.

l Increase/decrease the values by two by clicking on the signs.

Render from X to Y Image. Enter the numbers of the corresponding images to calculate a portion of the sequence.
First Frame is set to 0.
Number of images: Information on the number of images or selected frames to be rendered to make up the animation.

2. Anti-aliasing

Anti-aliasing: anti-aliasing Normal / High.

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.
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3. Radiosity

The calculation times depend on the value chosen.
This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.
Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.

4. Application settings

Define as default / Default settings / Apply to all viewpoints for the selected inspector :
Respectively allow the user to define current settings as the default, to use the default settings or propagate these set-
tings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.
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The Panorama Inspector

In this chapter you will learn about the following subjects:

Panorama List 188

Panorama List: for handling panoramas on the list shown.

1. Panorama
Focal Length: Changes the focal length when the slider is used or a value is entered in mm or degrees
(adjusts the angular opening of the camera).

Depth of Field: click then, in the Preview window, click to define the clear point of the scene, with the
rest remaining blurred. The cursor adjusts the blur amount.
Clipping Box: for defining clipping planes.
Show: in 2D View
Activate: Representation in Preview mode

2. Lighting
To handle light schemes linked to the view, select them from the drop-down menus.
Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.
Light Group: Links one or more light groups to the view. Selecting "None" deactivates the light groups.
Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.

3. Environment
Handles the background and foreground of the scene.
Defining a Background: Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic
Foreground Images

4. Visible layers: check them in the drop-down menu.
5. Coordinates

Camera XYZ Position.

Clicking on locks them and clicking on unlocks them.
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6. Tone settings

Set the Tone for the current view.

7. Post-production

Applies effects to the current viewpoint: The effects combine into, as well as with the parameters set in the
inspector.

8. Rendering Parameters

Prepares the document for final rendering.

NB: Editing the scene information such as the infinite ground, movement of the origin, redi-
mensioning of the model and the coordinates may be accessed via theWindow menu.

Panorama List

opens the panorama list. Each is displayed by name and preview thumbnail.

l To edit, double-click on the name.

l duplicates the selected panorama and its first node

l duplicates the selected node or the first node if the panorama is selected (In 2D View the new node over-
laps the duplicated node).

l deletes the selected item from the list.

Panorama Pop-up Menu

l Right-clicking on a view displays the pop-up menu:

Duplicate: use the original to create a new superimposed panorama or node.
Delete: the panorama or the node is removed from the list.
Add to: Perspectives List:
Add to: Parallel Views list:
Add to: VR Object List:
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Add to: Animation list:
Depending on the option selected, adds current view from Panoramas to Perspectives, Parallel Views, VR
Objects or Animations.
Edit Light: select a light, the inspector palette switches to Lights mode and the light is selected.
Edit Heliodon: The palette inspector switches to Heliodon mode and the heliodon is selected.
Make First Node: The selected node becomes the First Node, this is the first one displayed when playing the
panorama. When the node is already the first node a disabled "Is First Node" item is displayed.
Create links between nodes
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The VR Objects Inspector

Manages viewpoints defined by a camera, a target and a focal length. Each viewpoint is considered to be an inde-
pendent document with its own parameters which can receive its own environment.
A VR Object view is made up of several images taken from different points in a sphere. A view is defined by a cam-
era that moves in a sphere, a target, the center of the sphere and a focal length, as well as two horizontal and vertical
angular movement steps.

In this chapter you will learn about the following subjects:

VR Object List 192

VR Object List: for managing VR objects on the list shown.

1. VR object Navigation

VR projection choice: Hemispherical, Torus, Spherical.
Modifying values in angular horizontal and vertical step degrees.
Number of images: Indicates the number of images that will be needed to calculate the VR objects. This
number is dependent on the values defined for the angular horizontal, vertical steps and the horizontal angle.
Focal Length: Changes the focal length when the slider is used or a value is entered in mm or degrees
(adjusts the angular opening of the camera).

NB: An angular step of 10 degrees provides a good compromise between the number of views
needed (size of the file) and fluidity (your objects will not be jerky).

Depth of Field: click then, in the Preview window, click to define the clear point of the scene, with the
rest remaining blurred. The cursor adjusts the blur amount.
Clipping Box: for defining clipping planes.
Show: in 2D View
Activate: Preview Representation
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2. Lighting:
To handle light schemes linked to the view, select them from the drop-down menus.
Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.
Light Group: Links one or more light groups to the view. Selecting "None" deactivates the light groups.
Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.

3. Visible layers: check them in the drop-down menu.
4. Environment:

Handles the background and foreground of the scene.
Defining a Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic
Foreground Images

5. Coordinates:
XYZ Position of Center of VR

Clicking on locks them and clicking on unlocks them.
Horizontal Constraint: According to the trigonometric circle, turns the opening point of the VR object. Enter
a value in degrees.
Horizontal Angle: For restricting the opening angle. Enter a value in degrees.
Radius: the radius of the VR.

6. Post-Production:
Applies effects to the current viewpoint. The effects combine into, as well as with the parameters set in the
inspector.

7. Rendering Parameters:
Prepares the document for final rendering.

NB: Editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via theWindow menu.

VR Object List

opens the viewpoint list. Each is displayed by name and preview thumbnail.

l Double click on a name to edit it.
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l adds a viewpoint; deletes it.

VR Object Pop-up Menu

l Right clicking on a view displays the pop-up menu:

Duplicate: Uses the original to create a new superimposed viewpoint.
Delete: The viewpoint is removed from the list.
Add to: Perspectives list
Add to: Parallel Views List
Add to: Panoramas List
Add to: Animations list
Depending on option selected, adds current view from Perspectives to Parallel Views, Panoramas, or
Animations.
Edit Light: Choose a light. The inspector palette switches to Lights mode, and the light is selected.
Edit Heliodon: The palette inspector switches to Heliodon mode and the heliodon is selected.
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The Animations Inspector

Animations: General Information
A Sequence is defined by a camera: A viewpoint, an aim point and a focus distance.
Each sequence is considered as an individual document with its own parameters.

In this chapter you will learn about the following subjects:

General Animation Information 196
Sequence 196
Real Time Display: 197
Elements that can be animated 197

Animations List 197
Animation Coordinates 198
Animatable Camera Parameters 199
What can be animated 199
What cannot be animated 200

Animatable Heliodon Parameters 200
What can be animated 200
What cannot be animated 200

Animatable Light Parameters 201
What can be animated 201
What cannot be animated 201

Animatable Object Parameters 201
What can be animated 201
What cannot be animated 202

Animations List: for managing animations on the list shown.
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1. Animations

Depth of Field: click then, in the Preview window, click to define the clear point of the scene, with the
rest remaining blurred. The cursor adjusts the blur amount.
Clipping Box: for defining clipping planes.
n Show: in 2D View
n Activate: Preview Representation

2. Lighting
To handle light schemes linked to the view, select them from the drop-down menus.
Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.
Light Group: links one or more light groups to the view. Selecting "None" deactivates the light groups.
Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.

3. Visible layers: check them in the drop-down menu.
4. Environment:

Handles the background and foreground of the scene.
Defining a Background: Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic.
Background type: Foreground Images

5. Coordinates:
6. Post-Production: Applies effects to the current viewpoint: The effects combine into, as well as

with the parameters set in the inspector.
7. Rendering Parameters: Prepares the document for final rendering.

NB: Editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via theWindow menu.

See " Working with Camera Animation in 2D View" page 52

See " Working with Light Animation in 2D View" page 60

See "Working with Object Animations in 2D View" page 66

See "The Timeline Window" page 77

See " General Preview Display Shortcuts" page 215

General Animation Information
Animation makes it possible to produce and play a scene made up of one or more sequences.

Sequence

A sequence retraces the camera path in time.

NB: The camera may also be a fixed plane in which object lights, or a heliodon are animated.

The camera path is processed in:

l The Animations Inspector, (animating parameters, focal distance, association to lighting groups, depth of
field, roll, etc.).

l The Timeline window, (time management).
l The Preview Window (managing camera targets).
l The 2D View. (Managing paths: cameras, lights, objects).

Animating in a sequence of parameters for other inspectors:

Parameters respectively accessible from:
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l Lights Inspector*: Illumination configurations
l Heliodons Inspector*: Heliodon configuration
l Objects Inspector*. Object configurations
l 2D View: Creating and editing paths for moving cameras, lights and objects.
l Timeline Window: Creating and editing keyframes (changing parameter of an element at a T instant, inter-

polation of parameter changes between two keyframes), synchronizing keyframes of elements that either belong
or do not belong to the same inspector.

* NB: To animate the parameters for light, heliodon and object inspectors, they must first be displayed in the
Animation Inspector before being displayed in the relevant inspector, i.e. light, heliodon, object.

Real Time Display:

l Preview Window: Shows and plays in real time the result of adjustments.

Elements that can be animated

All elements can be animated except for those related to the Shader inspector, or which are listed as not being able to
be animated in:

l Animatable Camera ParametersSee "Animatable Camera Parameters" page 199
l Animatable Heliodon ParametersSee "Animatable Heliodon Parameters" page 200
l Animatable Light ParametersSee "Animatable Light Parameters" page 201
l Animatable Object ParametersSee "Animatable Object Parameters" page 201

Animations List

opens the sequence list. Each is displayed by name and preview thumbnail.

l To edit, double-click on the name.

l adds a sequence, deletes it.
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Animation Pop-up Menu

l Right clicking on a view displays the pop-up menu:

Duplicate: Starting with the current sequence, a sequence is created that takes up the position of the camera
but not the existing path.
Duplicate View and Path: Starting with the current sequence, a sequence is created that takes up the position
of the camera, the existing path and key frames.

NB: Only the camera path is duplicated; the paths of objects and lamps are excepted.

Delete: The current sequence is removed from the list.
Add to: Perspectives list
Add to: Parallel Views List:
Add to: Panoramas List
Add to: VRObject List
Depending on option selected, adds current view from Perspectives to Parallel Views, Panoramas, or VR
Objects.
Edit Heliodon: The palette inspector switches to Heliodon mode and the heliodon is selected.
Edit Light: select a light, the inspector palette switches to Lights mode and the light is selected.

Animation Coordinates
From the viewpoint (Position) and Target of the camera.

The Camera Position defines:

l Viewpoint position: Provides the x, y, z coordinates. Entering new values redefines the position.
l Target Position 2 options:

On a fixed vertex: The camera moves on its path aiming at a fixed vertex in the scene. The fixed vertex is
defined in the Preview window or in 2D View.
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Orientation on path: The camera moves tangentially to the path. Horizontal and vertical angles can be defined
relative to this tangent. The Distance provides the distance between the camera and the aim point.
Target on: choose between target on a fixed vertex or on an object defined as target.

NB: Using the Timeline, in a single sequence, the camera can change behaviour several times.

Animatable Camera Parameters

What can be animated

From the Cameras Inspector Editing in

Camera coordinates Animations Inspector - Coordinates tab - 2D
View

Target coordinates Animations Inspector - Coordinates tab - 2D
View

H target angle relative to the tangent to the
path

Animations Inspector - Coordinates tab

V target angle relative to the tangent to the
path

Animations Inspector - Coordinates tab

Activated and/or displayed clipping box

Modification box

Animations Inspector - Coordinates tab - 2D
View

Focus Animations Inspector - Coordinates tab - 2D
View

Colored background Animations Inspector

Depth of Field Animations Inspector

Atmosphere Animations Inspector

Roll Animations Inspector

Settings are available in the Animations Inspector.See "The Animations Inspector" page 195
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What cannot be animated

Cameras

Ambient

Changing a heliodon

Changing light groups

Background and foreground images

Changing the Photorealistic/Hatch ren-
dering engine

Animatable Heliodon Parameters

What can be animated

From the Heliodons Inspec-
tor

Editing in

Time Heliodons Inspector

Date Heliodons Inspector

Power of the Sun Heliodons Inspector

Celestial illumination Heliodons Inspector

Celestial color Heliodons Inspector

Color Heliodon inspector

Lens flare Heliodons Inspector

Halo type Heliodons Inspector

Lens flare power Heliodons Inspector

Parameters are available in theHeliodons Inspector. See "The Heliodons Inspector" page 145

What cannot be animated

Heliodons

Cities

Shadows ON/OFF

Shadow type

Contribution to radiosity

Colored sun On/Off

Orientation of North
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Animatable Light Parameters

What can be animated

From the Lights Inspector Editing in

Status ON/OFF Lights Inspector

Illumination type (omni, spot,
direct.)

Lights Inspector

Power Lights Inspector

Associating a halo Lights Inspector

Changing halo Lights Inspector

Shadows ON/OFF Lights Inspector

Soft shadows Lights Inspector

Shadow power Lights Inspector

Source coordinates Lights Inspector - Coordinates tab - 2D
View

Target coordinates Lights Inspector - Coordinates tab - 2D
View

Spot Opening Angle Lights Inspector - Coordinates tab - 2D
View

Fall-off Lights Inspector - Coordinates tab - 2D
View

Soft shadows bias Lights Inspector - Coordinates tab - 2D
View

Distance A Lights Inspector - Coordinates tab - 2D
View

Parameters are available in the Light Inspector. See "The Lights Inspector" page 151

What cannot be animated

Lights

Radiosity contribution

Animatable Object Parameters

What can be animated

From the Objects Inspec-
tor

Editing in

Coordinates Objects Inspector - Coordinates
tab

Rotation Objects Inspector

Dimensions Objects Inspector
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l For 3D vegetation: Plant sizes, colors, date, etc.
l For Billboards: Size, luminosity, brightness, etc.

Parameters are available in theObjects Inspector. See "The Objects Inspector" page 125

What cannot be animated

Objects

Scene coordinates

Scene rotation

Scene dimensions
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Artlantis settings enable you to organize your working environment.

In this chapter you will learn about the following subjects:

Preference Settings 203

Preference Settings
Artlantis settings enable you to organize your working environment.

Access: Edit Menu > Preferences

General

l Work units: In the drop-down menu choose (mm, m, cm, inches, feet and inches).
l Focal unit: select mm or degrees for the viewpoint inspector focus.
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l Default location: In the pop-up menu. The change becomes effective the next time a DWG, DWF, DXF, OBJ
and 3DS file that does not contain any location-related information is opened.

l Manual update mode: concerns the method of updating the positions of the camera, the viewpoint, the roll and
focal length.
In manual update mode, in the viewpoint list, the thumbnails will be updated when the use clicks the
"Update" button, or when a new view is activated.
The thumbnails in the list will not be updated when Shaders, lights or backgrounds are modified.

l Display Expert Rendering Parameters: when checked, in the viewpoint rendering parameters window, this ena-
bles refinements to be made using the Expert Viewpoint Rendering parameters.

Preview

l Maximum Preview size:
Choose the maximum size of the window contents (using the shortcut Control + ). In the pop-up menu (640,
800, 1024, 1200), the value means the size of the preview image displayed in that window.

l Automatic permutation in OpenGL mode: when this box is checked, the display mode switches from pho-
torealistic to OpenGL mode when the camera is moved. Allows the display on small hardware configurations to
be accelerated.

NB: The refresh time of the window is proportional to the size of the display.

l OpenGL Options
The following options affect the Preview window rendering display in OpenGL mode.

l Camera light:
when this option is checked, it simulates the white omni-directional light emitted from the camera. The scene
is always lit.

NB: This option is independent of the anti-aliasing of the final rendering.

l All light sources:
When this option is checked, OpenGL takes into account all active light sources: lights and sun

NB: The refresh time of Preview slows down when the option is activated.

l Last manipulated Light Shadow:
When this option is checkec, OpenGL takes into account shadows cast from the last light or sun manip-
ulated.

NB: The refresh time of Preview slows down when the option is activated.

l FPS:
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Preferences - Preference Settings

Increases or reduces OpenGL navigation fluidity. The greater the number, the better the fluidity. On the other
hand, a low figure gives better image definition.
Move the slider or enter a value of between 1 and 30 images per second.

Final Renderer

l Rendering output folder:
Two choices for the default rendering output folder:
n Document directory: The renderings are saved at the same level as the current file.
n Default output directory: Click on the button to choose the folder.

Default file name: either the name of the viewpoint, or the name of the document plus the name of the
viewpoint.
Default file format: in the drop-down menu, choose: JPEG, BMP, TARGA, PICT, TIFF, Photoshop or
Piranesi.
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Mouse and Keyboard Shortcuts

Available in 2D View and Preview.

In this chapter you will learn about the following subjects:

General 2D Shortcuts 208
2D Shortcuts - Working with Perspectives 209
2D Shortcuts - Working with Parallel Views 209
2D Shortcuts - Working with the Clipping Box 209
2D Shortcuts - Working with Objects 211
2D Shortcuts - Working with Lights 212
2D Shortcuts - Working with Heliodons 212
2D Shortcuts - Working with Panoramas 214
2D Shortcuts - Working with VR Objects 214
2D Shortcuts - Working with Animations 215
General Preview Display Shortcuts 215
Activated Object Inspector Preview Shortcuts 216
General Preview Shortcuts 217
Perspective Inspector Preview Shortcuts - Site Insertion 218
Activated Heliodon Inspector Preview Shortcuts 218
Activated Shaders Inspector Preview Shortcuts 220
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General 2D Shortcuts

Actions Combination and Key Strokes

Enlarge the display.
&

Reduce the display.
&

Fit to Window.
&

Camera pan movement.

& or
Enlarge a part of the window by drawing a rectangle
with two opposing angles

&

+ or - Dynamic Zoom depending on the target.

Change 2D View.
Depending on the view, press the key followed by one
of the keys on the keyboard:

1 (Above), 2 (Front), 3 (Right), 4 (Left), 5 (Rear)

Previous view.

Next View.
 &

Activate the Pop-up menu.

Force a movement on a 45° incremental scale.

 &
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2D Shortcuts - Working with Perspectives

Actions Combination and Key Strokes
Inspectors: Shaders, Lights, Heliodons, Objects and Per-
spectives.

Graphically move the camera, the target or the
bisector.

Graphically modify the focal distance.

Duplicate a Viewpoint.

 &

2D Shortcuts - Working with Parallel Views

Actions Combination and Key Strokes
Inspectors: Shaders, Lights, Heliodons, Objects, and Parallel
Views.

Graphically move the camera, the target or the
bisector.

Graphically modify the section width.

Duplicate a Viewpoint.

 &

2D Shortcuts - Working with the Clipping Box

In order to use the Clipping Box tool, the "Show" option must be checked in the Perspectives inspector.

The command takes effect with all inspectors
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Actions:

Clipping box displayed.

l Blue contour line entry.

l When the contour line moves, the cutting plane operates in Preview mode.

l To create an angle to the clipping box, grab the handle on the circular cursor and turn it.
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l Move the origin of the circular cursor by clicking and dragging from the center.

The recall lines coming from the center help with positioning.

2D Shortcuts - Working with Objects

Actions
You can only manipulate objects in the Objects
mode.

Move an object.

Duplicate an object.

 &

Duplicate an object several times.

 &  &

increases

or

decreases the number of copies

Redefine the anchor point of an
object

 &

Page - 211



Chapter 20

2D Shortcuts - Working with Lights

Actions Combination and Key Strokes
Inspectors: Shaders, Lights, Perspectives, Parallel
views, Panoramas, VR Objects, Animations.

Graphically move the source, the target and the bisector,
modify the light cone and the lighting distances.

Duplicate a light.

 &

Duplicate a light several times.

 &  &

to increase

or

decrease the number of copies.

2D Shortcuts - Working with Heliodons

Depending on the operation chosen in the Heliodons inspector, there are three options available: Location, Manual
and 45°.

Location option:

l Defines the direction North by moving the yellow point around the compass.

Page - 212



Mouse and Keyboard Shortcuts -

l Result: Shadows are recalculated.

Manual Sun Position option

l Graphically moves the sun icon around the yellow circle.

l Result: Shadows are recalculated.

There is an option for shadows to be projected at 45° depending on the position of the viewpoint.

l The angle between the viewpoint bisecting line and the position of the sun always remains at 45°.

l Result: Even after the camera is graphically moved, the shadows remain at 45° to the camera.
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2D Shortcuts - Working with Panoramas

Actions Combination and Key Strokes
Inspectors: Shaders, Lights, Heliodons, Objects and
Panoramas

Graphically move the camera, the target or the bisector.

Graphically modify the focus (Perspectives, VR Objects,
Animations)

Graphically modify the view width (Panoramas)

Duplicate a Viewpoint.

 &

2D Shortcuts - Working with VR Objects

Actions Combination and Key Strokes
Inspectors: Shaders, Lights, Heliodons, Objects and
VR Objects

Graphically move the camera, the target or the bisector.

Graphically modify the focus (Perspectives, VR Objects,
Animations)

Graphically modify the view width (Panoramas).

Duplicate a Viewpoint.

 &
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2D Shortcuts - Working with Animations

Actions Combination and Key Strokes
Inspectors: Shaders, Lights, Heliodons, Objects
and Animations

Path edit mode:

For graphically moving the camera, viewpoint, bisecting line,
path, or a control point.

Time edit mode:

For moving a keyframe.

Graphically modify the focal distance.

Extend a path.

 &
To the path's final control point

General Preview Display Shortcuts

Actions Combination and Key Strokes
Enlarge the content of the Preview window.

NB: the camera does not move.

Reduce the content of the Preview window.

NB: the camera does not move.

Fit to Window.
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Activated Object Inspector Preview Shortcuts

Actions
Combination and Key

Strokes

Select and/or move the object.

Duplicate the object.
&

Replace the object with a different one using a drag & drop from the Catalog or
Desktop.

&

Move with no change of the hierarchy.
&
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General Preview Shortcuts

Actions Combination and Key Strokes
Parallel
Views and
Perspectives

Mode.
Panoramas
Mode.

VR
Objects
Mode.

Animations
Mode

Turn the camera around the clicked point N/A N/A

Turn the camera around its target

 &

N/A

 &

Turn the camera on itself. N/A

The + or - Dynamic Zoom is focused on the position
of the cursor. N/A N/A

Change the focus distance. N/A N/A

Camera pan movement. N/A N/A

NB:
For a cam-
era with no
path.

Pan To: Place a viewpoint perpendicular to a sur-
face.  &

Click
N/A N/A  &

Click

Move the camera through the scene.

When the cursor is pointed towards the top of the win-
dow, the camera moves forwards in the scene; when
it is pointed towards the bottom, it moves laterally,
towards one of the sides.  &

Click
N/A N/A

 &
Click

NB:
For a cam-
era with no
path.
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NB: In Shaders, Lights, Heliodons and Objects modes, you can navigate just like in the viewpoints inspector

by releasing the current Edit Shaders mode. Press the key and then use the com-
binations described in the table.

Example:
In the Shaders mode with a Perspectives display, you must use the following shortcut to turn the camera around its

target: & & . Once you release , the Edit Shaders
mode is reactivated.

Perspective Inspector Preview Shortcuts - Site Insertion

Actions Combination and Key Strokes

Move the origin of the trihedron, pivot the axes or slide the yellow cursor
to the defined reference axis.

Move the origin of the axes while maintaining the directions.  &

Show/Hide the magnifying glass. Each incrementation increases the con-
tent of the magnifying glass from x2 to x8.

Activated Heliodon Inspector Preview Shortcuts

Actions
Combination and Key

Strokes
Manually move the sun.

NB: Only available when the Manual option is selected in the Heliodon inspec-
tor.

Define fog start (advanced heliodon settings).

Click on the target icon and then click on an element in Preview.

Page - 218



Mouse and Keyboard Shortcuts -

Example of manually moving the sun:

Preview: Manually moving the sun.

Result after movement.

NB: If there is no sun in the current view, you can display it by modifying its position in the 2D View.

Example of positioning the start of fog:

Click on the airplane in the foreground to define the fog start.
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Click on the airplane in the background to redefine the fog start.

Activated Shaders Inspector Preview Shortcuts

Actions
Combination and Key

Strokes

Select a Material or a Shader.

NB: The material is highlighted

Select a material or a Shader located behind a transparent sur-
face.

 &

Select a material or a Shader by reflection in another material.

NB: if the Shininess slider is at maximum.
 &

Duplicate a Shader or texture.
 &
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